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Configurations & Conventions

VX4000 Series Scanner

This chapter will introduce you to the VX4000 scanning system and how to interact with it.
We recommend that first-time-users and those needing a quick refresher course on the
scanning system read this chapter thoroughly; the information will make your scanning
experience more enjoyable. The parts of the scanner, the system configuration and
command conventions are all covered here.
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Reseau Assembly

Backlight Box Assembly

Backplane
(Behind photos)

Upper Curtain

Z Cover

Reseau Plate
(In front of
photos, not

visible)

Lower Curtain

Back Cover

X Cover

Front Cover

(Figure 1)
VX4000 Scanner



Configurations & Conventions

System Configuration

CONVENTIONS

The VX4000 Scanning System, shown below, is configured with a scanner pc controller,
image monitor, controller monitor, and scanner. The VX4000 application (vxscan) from the
scanner pc controller.
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VX4000 Scanner Image Monitor
Scanner

Controller Controller Monitor

Scanner Controller The component that houses the computer hardware and software
for the VX4000 scanner and the NT based formatter.

Image Monitor The monitor on which a preview of the image is displayed.

Controller Monitor The monitor which is used to view the vxscan user interface.

Ethernet A standard Ethernet network that connects the Scanner
Controller to remote network devices (ie. pc, workstation,
server).
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VX4000 Conventions
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1 Using the Mouse

Within the VX4000 user interface, the mouse is used to move the camera, select options
and set scanning parameters.

Apte: The only time you press the right-mouse

button is to move the camera. Otherwise, always use
the left mouse button.

Mouse Pointer Shapes

The mouse pointer changes shape when it is in different locations within the user interface.
These different shapes provide visual cues to the current activity.

A The pointer usually appears as an arrow cursor.

+ In the backplane representation, the pointer appears as a cross for adjusting
the size and shape of a scan area. A cross also appears on the image
monitor for selecting points of interest.

r When an inverted "L" bracket appears, the user can create a new rectangle
for defining a region of interest.

$ Holding down the right mouse button will turn the pointer into a cross with
arrows which allows the user to adjust the camera position on the
backplane.
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Clicking, Double-Clicking, and Dragging

“Click” means to press and release a button without moving the mouse. “Double-click”
means to click a button twice in rapid succession. “Drag” means to press and hold a button
while moving the mouse pointer.

CONVENTIONS

]
(2]
Z
o
=
&
>
e
[
Z
o]

o

Il Input Fields

Input fields are used to enter text or numerical values. For example, names and directory
paths of photo files or resolution values. To select an input field, point to it and click the
left mouse button. The text insertion point is then marked by a blinking | shaped cursor in
the input field. Type information into an input field. The <Backspace> and <Delete> keys
can be used to delete unwanted characters. The arrow keys move the cursor left and right.
When you are done entering text into an input field, either click on another input field or
option menu or hit the <Enter> key. This will cause vxscan to accept your input. Pressing
<Enter> in a multiple-line text field causes the cursor to advance to the next line.

Tip: Double clicking on the text will select all the
text to be overwritten. Also, you may select sections

of text to delete or overwrite by clicking and dragging
over the desired text.

Il Message Windows

Message windows provide helpful information about system # wnacen Working
operations. A message window appears automatically and B scumirg: 222 dow
will often prompt you to click OK to continue. Sometimes a

message window does not require any action. For example, Carcal

when you click Scan, the vxscan Working Window (Figure 2) E==
displays the progress of the scan. vxscan Working Window

(Figure 2)
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1V Pull-Down Menus

Pull-down menus give you access to more options. There are two ways to choose a function
from a pull-down menu using the mouse:

L, |
L The pull down menu available when Edit is selected
from the main menu
(Figure 3)

e Drag method: Point to the menu you want to display, press and hold the mouse
button, drag the pointer and highlight the desired function, and then release the
button.

e Click method: Point to the menu you want to display, click the mouse button once
to display the menu. Point to the desired function and then click again.

V Selection Window

When you select “open” or “save as” a selection window (Figure 4) appears with the
following fields:

el LA
DT
[ g dalmil iy

.t

Open Photo Selection Window
(Figure 4)
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Configurations & Conventions

Filter

This filter determines what files will be displayed in the “Flles” text field and from which
directory. For example, in Figure 4, all files that end with “.ph” in the “C:\USERS\scans”
directory will be displayed in the “Flles” text field. Filter uses regular NT naming
conventions.

CONVENTIONS
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To start the search using the filter,

1. Click in the “Filter” input field and type the directory where you think the file is
located, an asterisk, and the extension if one exists. Use the <Backspace> and
<Delete> keys if necessary. The asterisk is used as a wild card so that any file with
that extension within that directory will be displayed.

2. To make the filter take effect, click Filter at the bottom of the window. You may also
press <Enter>.

Directories

The “Directories” text field lists all the directories which reside below the specified directory
in the “Filter” input field. To scroll through the list of directories, click either the up or down
arrow. To see the entire path, click the left or right arrow.

To select a directory, use one of the following:

1. Double click on one of the directories listed in the “Directories” text field to
highlight it. The “Files” text field then lists those files for the directory you selected.

2. Click on the directory you need, then click Filter.

To go one directory up the directory tree, double click the directory name which is followed
by two dots (ie. C:\Users\.. in Figure 4).

Files

The “Files” text field lists the files in the specified directory that match the filter.

12
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Click on the desired file in the Files text field. That file name appears in the “Selection”
input field.
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Selection

The “Selection” input field displays the current file you have selected. Use the “Filter” input
field and “Directories” and “Files” text fields to search for and select a file. If you already
know the name, you can type it directly into the “Selection” input field.

VI Hot Keys

The following key combinations will perform the corresponding task. Further explanation of
the functions can be found on the pages listed.

Ctrl-Kk  Quick Point Model . .............. 75
CtrkN  NewROIl ............ ... ....... 95
Ctrl-P  Release Point .. ................. 96
Ctrl-R  Delete Rectangle ................ 96
Ctrl-H  Open Histogram Window .......... 100
Ctrl-S  Open Preferences Window . . .. ...... 101

IV Starting the Scanner

1 Power up and Boot

If the system is not yet powered on, do so now. The power button for the controller (the
Windows NT PC) should be located on front of the PC. Press it, wait through the memory
checks, and press <Enter> when prompted to boot into Windows NT 4.0. While this is
booting, power on the scanner and confirm that the green LED on the front left of the
scanner is lit. The power switch for the scanner is located on the rear of the scanner, on the
left side and above the power cable.

13
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2 Login

By now, you should see a message on the controller monitor telling you to press <Ctrl>
<Alt> <Delete> to login. Press these three buttons simultaneously and you will be
presented with a login window. The user account that you would normally use to run the
vxscan application is user “vexcel”. The password for “vexcel” is normally “scanbl”.

CONVENTIONS
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Once you are logged in, you should be able to look on the Windows desktop and see the
icon to begin vxscan.

3 Starting vxscan from your NT desktop

To start vxscan from your NT desktop, double click with the left mouse button on the Vexcel
icon, and vxscan will begin. You can also start vxscan from a Command Window (MS-DOS
prompt) by going to the project directory and typing “vxscan”. First, a Command Prompt
Window will appear which provides information about your scanner’s performance as the
scanning process executes. This window is not vital to normal scanning procedure, and is
typically covered up by the next window to appear, the vxscan Main Window.

4 Scanner initialization process

When vxscan first begins, it sends a homing process to the scanner. You will notice that the
backlight will flash and the tower (the part of the scanner which is mobile, and contains the
camera) will move to the left, the camera will move down, and you will hear the sounds of
other internal components being moved as well to their initial starting position.

Note: It is vital that no objects be placed on or close to the scanner,
as they may interfere with the homing motion and other motions
throughout the scanning process. The VX4000 scanner, while more
forgiving than other high resolution/high accuracy scanners on the

market, still requires precise calibration to achieve its results.
Jamming of motion by foreign object, or even such actions as resting
one’s arm against the camera, can result in changes in the scanner’s
geometry which will affect its performance. Warn all people who will
come in contact with this system to exercise care in its use.

14
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Manual Conventions

Action button text: This is text on a button that, when clicked on, will generally cause
the software to perform a task, open a different window, or allow the user to choose a
parameter (such as “positive” or “negative”, or a scanning format such as “TIFF” or
“BIP™). All such text will appear highlighted, such as “To open the Histogram Window,
click on Brightness, Contrast, or Histogram in the “Current Scanner Settings” area.

“User interface descriptive text”: This is text that labels a part of the user interface, such
as “Current Scanner Settings” or “Height” or “Resolution” in the “Current Region of
Interest Settings” area. Clicking on this text will have no effect on anything.

‘Menu item text’: Single quotes around text signifies text that appears either on the
menu bar itself, or as an option when an item on the menu bar is clicked. The quotes
signal to the reader that this is the text that should be chosen to achieve the desired
effect, such as opening a window or deleting a rectangle. For example, “From the Edit
menu, select ‘Acquire Points’ to open the Acquire Points Window”.
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Scanned on a VX4000HT from a color negative compliments of PASCO corporation

STEP BY STEP
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Step by Step
|

Introduction

This chapter will take you, step by step, through two types of typical scanning sessions:
Scanning from Scratch, and Scanning Multiple ROIs from One or More .ph Files. Short
explanations will be provided as you go. If this is your first time scanning, each section will
point you to different sections of the manual which will give detailed explanations. If you
have simply forgotten a step or need a little refresher on what comes next in the scanning
process, you've come to the right place. You may wish to have available a well detailed,
monochrome diapositive to practice with.

Scanning from Scratch
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This section will guide you through the procedures necessary to perform a single scan on
an image that has not been previously scanned.

1 Mounting the Image

1 Open the backlight box assembly by grabbing the top of the backlight
box assembly and gently pushing it away from the reseau plate.

See also:
Opening the backlight box assembly ....... 71
Proper scanning attire ...........cccocevevenennne 72

2 Place the image, emulsion side towards the reseau (the etched grid on
the front glass plate), in the backplane viewing area. If you have more
than one image, place the images side by side in the backplane.

See also:
Emulsion testing ........cccccevvecevecvenieneens 71
3 Close the backlight box assembly snugly. The image is now mounted.
See also:
Closing the backplane .........cccocoecveinins 71

17
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Il Create the Rectangle

e o Pemim =) I AT
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& _: —:l < Backplane Representation >
= -
/] -

~——— Camera Field of view

vxscan Main Window
(Figure 5)

When you first start vxscan, the vxscan Main Window (Figure 5) will appear with one box in
the backplane representation (the large beige section in the lower right part of the vxscan Main
Window). The dark blue box represents the camera’s field of view. If you move the mouse
pointer inside the backplane representation, the curser will become an inverted “L". Left
clicking on the mouse will “drop” a red rectangle with the dimensions appearing in the

“Current Region of Interest Settings” area. This rectangle represents the boundaries of the
region of interest (ROI) on the backplane.

18
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Set the resolution in the “Current Scanner Settings” area to 100
microns. This increases the area of the camera field of view, allowing
you to see more of the image.

See also:
RESOIULION .. 81
Camera Field of VIEW ... 42

Move the camera so that the point where you want the upper left-hand
corner of the rectangle to be is visible on the image monitor.

See also:
OF=1 1 41<] - R TTTTTTT TSR 42

In the vxscan Main Window’s backplane representation, move the
cursor inside the camera field of view; a “+” should now appear on the
image monitor.
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Place the “+” where you want the upper left-hand corner of the
rectangle to be and left click the mouse. A red rectangle will appear.

Move the camera so that you can see on the image monitor where you
will want the bottom right-hand corner of the rectangle to be.

See also:

In the vxscan Main Window, left click the bottom right-hand corner of
the rectangle and stretch it so that it appears on the image monitor.
Use the image monitor to guide you, stretch the bottom right-hand
corner of the rectangle to the proper location.

See also:

Rubberbanding .......cccccooeiiniiniiiiieeee 82

Roaming with the camera, verify that all the corners are properly
placed to cover the target area.

See also:
OF-1 1 41=] - N TTTEEET TR 42
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111 Resolution and Radiometric Controls

vxscan's “Current Scanner Settings” (Figure 5) area contains several resolution and
radiometric settings that affect your preview of the image. The image monitor will reflect the
changes made to these settings, but when the image is scanned, only those settings in the
“Current Region of Interest Settings” area will be used. Select the Apply to ROI button to
apply any changes made in the “Current Scanner Settings” area to the “Current Region of
Interest” area before scanning.

1

Change resolution in the “Current Scanner Settings” area to the
desired scanning resolution.

See also:
RESOIULION ..o 81

Select Intensity or Density Mode.

See also:
INEENSILY .o 59
DENSILY .eveceeecece e 49, 60

Roam ROI for brightest area. With that area visible on the image
monitor, adjust brightness so that the histogram shows just a few
pixels at 255.

See also:
HIStOQram ......cccooeiiiiinieceee e 56
Brightness ... 37

Roam ROI for the darkest area. With that area visible on the image
monitor, adjust contrast so that the histogram shows just a few pixels
at 0.

See also:
HIStOgram ........ccceoeieieneenerese e 56
Brightness ..o 37

20
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Roam ROI and use the histogram to verify that radiometric settings are
properly set throughout the ROLI.

See also:
CaMEIA ....ooeiiieeee e 42
HisStogram .......cccceveviecvie e 56
If having difficulty setting up a good histogram, apply a Custom LUT
See also:
Look Up Tables .......cccceevvrerevieieeceeceeiees 66, 92, 108 ‘_1’
m
Apply values in “Current Scanner Settings” area to “Current Region of :
Interest Settings” area. =<
See also: t_l|)
APPIlY 0 RO ..o 111 m
Apply t0 Scanner ........ccccceveveeeveece e 114
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IV Completing Current ROl Settings
The ROI you are creating will be saved upon scanning. The settings for that ROl may be
saved in a .ph file.

1 Name the ROI, making sure to have the correct path and corresponding

host.
See also:
a File Naming Conventions..... 78
- HOSES oo 57
/]
> 2 Set format type.
0
o See also:
= FOrMatS .....oovuveeeeeerereereereneene. 51
/]
3 Set Local or Remote Host.
See also:
LocCal ..o 119
Remote ......ccccvvveeeeeeiiciiieeen, 78
4 Set Absolute or Relative Mode.
See also:
Absolute/Relative .................. 120
Relative ......ccccceccveeeeecivieecee, 79
5 Set Normal or Mirrored Mode.
See also:
Normal/Mirrored..................... 119
6 Save the photo file (.ph file).
See also:
|24 010 (0 N 72

7 Start the scan by clicking Scan. When scanning more than one ROI,
click Scan All.

22



Step by Step
|

Scanning Multiple Regions of Interest
(ROIs) from One or More .ph Files

1 Multiple Regions of Interest

When setting up a scan, it is often convenient to use multiple regions of interest. For
instance, if you have more than one image in the backplane, a region of interest may be
placed around each. Also, you may wish to scan an entire image at a low resolution, and
then scan certain locations in that image at higher resolutions (ex. Figure 6).

Backplane
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Representation of backplane, aerial photo and multiple ROIs (top) and how
this would look in the backplane Representation on the vxscan Main Window
(bottom)

(Figure 6)
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Functions for manipulating ROIs are available under Edit on the menu bar. To create
additional ROIs, select ‘Edit’ > ‘New ROI'. The mouse pointer will be represented by an
inverted “L” cursor in the backplane representation. Move to the top left of the region you
wish to scan, then click the left mouse button to drop the new ROI. It will have the same
dimensions and settings of the ROI that already exists within the photo file (.ph file) which
is open. At this point, change the dimensions, resolution, and radiometric settings as
desired for your new ROI. Before scanning, remember to also change the ROI name, since
it comes up by default with the same name as the ROI present in the (.ph file).
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Tip: It is often more convenient to perform any
changes to its settings before “dropping” the new ROI

in the backplane representation, The name,
resolution, dimensions and other values can all be
changed before placing the ROI.
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Tip: If the quantity and location of images mounted is
consistent each time you scan, you may wish to save
multiple ROIs to your default photo file (default.ph).
To do so, create your regions of interest, setting them

up with appropriate default names and settings
(resolution, contrast, brightness, etc.). Then, select
from the menu bar ‘File’>’Save’>’Photo’ (if default.ph
is the photo file open) or ‘File’>’Save As’ and specify

default.ph as the file to be saved.

Il Multiple Photo Files

More than one photo file (.ph file) may be opened to
allow scanning of regions without having to create
multiple ROIs. For example, if you wished to scan two
Images with the same dimensions and a photo file
already exists with one ROI and the settings you wish to
use for scanning, you may open that photo file twice,
once for each image. Both ROIs which are present will
have the same name, so remember to assign them
different names before scanning.

Photo files are opened by selecting ‘File’>'Open’>
'Photo’. After selecting ‘Photo’, the Open Photo Window
(Figure 7) will appear. To open multiple .ph files, repeat
this process after opening the target file.

See also:
File, open .....cccccevvevvveeieens 91
Selection Window .................. 11

Filtes

Cahamer s, phy

Biresrioe ey Filss
FUTTTI [ 1
C1himsrah .
C1himer ot st
C1himtr gt
C1himsrahaad rak

S lmctian

II::'-u.nlr:'-\.

1 4 Filtar Cancal Halp

Open Photo Window
(Figure 7)
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Note: When multiple photo files are open, only the .ph
file associated with the current ROI (highlighted in the
List of Regions) will be displayed in the text field next to
“Photo:”. The .ph file name will change as you click on
ROIs from different .ph files in the List of Regions.

Note: The vxscan Main Window will not indicate that
more than one photo file is open, so you must take
care if you choose to save changes so that they will be
applied to the appropriate file. You may find that using
multiple ROIs is a simpler option for scanning more
than one region.
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Infrared imagery compliments of Surdex Corporation, scanned on a VX4000HT
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Details & Definitions

Introduction

In this chapter, more time will be spent describing the actual terms and functions and how
you will apply them. This chapter is ordered alphabetically, and contains descriptions and
usage of the functions presented on the User Interface, plus scanning terminology and tips
which have been acquired through the experiences of our customers over the years.

Accurate

Selecting this feature will result in a reseau grab being performed for accuracy before the
image grab is performed. This allows the view on the image monitor to be located accurately
relative to the actual geometric position of the camera. When performing functions such as
Acquire Points, or even when needing to place an ROI accurately, selecting this feature will
produce more accurate results.

See also:
APProXimate ..........eeeeeviiiieeeeieeeeeiiiiiiinnn 34
Accurate/Approximate ............ccceevvennennn. 112

Acquire Centers

The Acquire Centers computation requires that the points be centrally symmetric and light-
colored against a darker background. The pug holes (circular holes drilled in the film
emulsion) used by many photogrammetrists meet these requirements. Poor contrast or non-
symmetrical points could cause vxscan to miscalculate the point, or to select an area too big
around the point.
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To acquire centers:

1 From the Edit menu, select ‘Acquire Centers’. The Calculate Centers Window (Figure 8)
appears.

2 Highlight a point of interest in the list, for example, "center 1".
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3 Move the camera over the point you want to

digitize and zoom to the resolution required for
your application. You will see a green box on the 1 3
image monitor which you can resize over the point | |7 §
by moving the upper left and lower right corners. | |center 4
This box is used to constrain the area that vxscan | |=™=" 2 ;
uses for calculating a center. The box narrows the
search region, isolating the point from other Lalculate |
radiometric highs.
4 Click Calculate to find the point value. A plus sign
(+) is displayed on the image monitor confirming [ o ] [ cancet |
the point and an asterisk appears next to the point -
name listed in the Calculate Centers Window. e ey

8 Continue using the above steps to acquire additional centers.

6 The following three buttons assist the user during this function:
Undo - undoes your last action, a delete or an undo.
Delete - deletes the current (highlighted) digitized point.
Cancel - exits the Calculate Centers Window without preserving any digitized
points.
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7 When you are done acquiring centers, select OK.

Note: Always use the highest resolution possible
when acquiring centers and make sure that the Current

Scanner Settings are such that the points you will be
capturing with Acquire Centers have high contrast.
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ANpte: Acquired centers are stored in the .ph file and

are only saved if you save the .ph file prior to exiting
vxscan.

Acquire Points

To acquire points:
1 From the Edit menu, select ‘Acquire Points’. This

bring up the Acquire Points Window (Figure 9). T -
Fid £
2 Highlight a point of interest in the list, for example, | fia: |
nes n H H FI'j'-'
fid 1" (fiducial 1). Finl F r? o
[ | raic | .I_II ﬂ
3 Move the camera over the point you want to digitize | E "-:
and zoom to the resolution required for your —— iauianin o
application. Place the mouse pointer over the point i | timin | 7
you want to digitize. Acquire Points Window
(Figure 9)
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4 Digitize the point using the left mouse button. An asterisk appears next to the point
name listed in the Acquire Points Window, and a cross should appear over the point
itself. Confirm its accuracy.

S Continue using the above steps to digitize additional points.

6 When you are done digitizing, click OK.

7 The following three buttons assist the user during this function:
Undo - undoes your last action, a delete or an undo.

Delete - deletes the current (highlighted) digitized point.
Cancel - exits the Acquire Points Window without preserving any digitized points.

See also:
Acquire Centers ........cceveevveeiiiiieeeeeiiinn, 29
Frame Relative ROl ......ccovevieiiiiiiiaian 53

Tip: When using Acquire Points, be sure you are in
Accurate Mode. Otherwise, your point locations will
often appear shifted when the image monitor view is
refreshed.
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Note: Like acquired centers,acquired points are stored
in, and can be retrieved from, a Photo File.
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Note: Digitized points are stored in the .ph file and
are only saved if you save the .ph file prior to exiting
vxscan. The point names and corresponding X and Y
coordinates are stored in the .ph file and can be used
in post processing. Points are stored in scanner

coordinates (microns from the upper left hand corner
of the scanner). You can also write your own software
to read data from the .ph files. Contact the Customer
Support Department at Vexcel Imaging for more
information on these features.

Active ROI (Region of Interest)

An active ROl is the ROI represented by a red box in the backplane representation. This ROI
will have its settings displayed in the “Current Region of Interest Settings” area, and any
changes you make in these fields will apply only to the active ROI.

See also:
Backplane representation ....................... 36
Inactive ROI ......coovvviiiiieiieee 58
List of Regions ..........ccccvvviiiiiiiiiiiiien. 78
Region of Interest ...........coovvvviiiiiiiinnnnn. 76
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AFD

See also:
Automatic Film Drive

.ah File

The .ah file is produced when 10T is enabled. This file will be written to the same
directory as the resulting images. The following information is included in the .ah file:

1 The fiducial locations in image space (pixel based)
2 The calculated image to camera system transform parameters based on the following
formulas: X' = A+ Bx + Cy, Y = D + Ex + Fy, where:
x and y are pixel based fiducial locations within the scanned image space.
X' and Y’ are millimeter based fiducial location within camera space.
A and D are transform coefficients in units of millimeters.
The parameters will be written in the following order: ABCDEF.
The following statistical information will be written:
The x, y and composite x/y residuals (in millimeters) for all fiducials.
The x, y and composite x/y RMS values for the residual data described above.
3 The calculated camera system to image transform parameters based on the following
formulas: x =G + HX' + IY', y =) + KX" + LY’, where
G and J are transform coefficients in units of pixels.
B, C, E, and F are transform coefficients in units of millimeters/pixel.
H, |, K and L are transform coefficients in units of pixels/millimeter.
The parameters will be written in the following order: GHIJKL.
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A complete .ah file can be found in Appendix IlI

Approximate

This function will result in image grabs being performed rapidly when you stop moving the
camera across the backplane representation. This allows for the quicker setup of an ROI,
but will result in “sloppier” ROI placement. For more accurate placement of ROIs, and for
using such functions as Acquire Points, you may prefer to use Accurate Mode.
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See also:
ACCUIaLe ....vviviieieee e 29
Accurate/Approximate .........c.ccoeeeveieennnnn. 112

Auto Calculate Dimension

vxscan uses three variables to define the dimensions of an [ E——
ROI: resolution, size in pixels, and size in either |™" |

millimeters or inches. One of these dimensions is ;
calculated while the other two are defined by the user. The | .. oy ——
“Auto Calculate Dimension” option is used to specify ——
which dimension you want automatically calculated. The
two dimensions you do not select for automatic calculation
then become variables for which you can enter the
information. For example, if you select “Resolution” for
Auto Calculation Dimension, the vxscan Main Window

provides input fields for size in mm/inches and size in Preferences Window
pixels in the “Current Region of Interest Settings” area to (Figure 10)
allow you to type in the information.

Remember that the choice you make for automatic calculation affects your control of those
dimensions. For example, if you have selected "Size in mm/inches" for automatic
calculation, you will not be able to dynamically resize (“rubberband”) an ROI rectangle in
the backplane representation because the system will compute the dimensions for you.
Likewise, if you have selected to have the resolution automatically calculated, you will not
be able to adjust the resolution, only the size in pixels and the size in mm/inches.
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See also:
ReSOIUtioN ....ooevieiiiiieeee 81
Region of Interest ...........coovvvviiiiiiiinnnnnn. 76
Rubberbanding ............cccviiiiiiiii. 82
Size iIn MM/INCNES .......ovvviiiiiiiii, 83
Size iN PIXeIS ...coooiiiii 83

35



Details & Definitions
I

Automated Film Drive (AFD)

AFD is a peripheral device which may be integrated with the VX4000 to allow for
continuous roll scanning. vxphotolist, the software used to control the AFD, allows the user
to specify the number of frames on a roll and the radiometric settings to be used. The AFD
will scan all frames specified without the need of user attendance. This device will function
with many roll sizes, and you may specify full frame or even specific area scanning. AFD may
also be combined with IDAS for a simple to use, and fast, bundle adjustment population
tool.

Five planes of motion are present in the VX4000 and are referred to as axes. The camera is
moved across the backplane in the x and y axes, then may move in and out on the z axis. In
front of the camera is a lens which moves in and out and is the fourth axis. A filter wheel
with color and density filters constitutes the fifth axis. VX4000 systems with the AFD will
also have an automatically opening backplane, but it is not referred to as an axis.
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Backplane

This is the physical scanning area of the VX4000. With approximate dimensions of 10”x20”
(25.4cm. x 50.8cm.), the backplane is where imagery will be placed for scanning.

See also:
Backplane Representation...................... 36
Mounting an Image ............ccccvvvvvvvnnnnnnnn. 71

Backplane Representation

This is the vxscan Main Window representation of the actual physical scanning area of the
VX4000 (backplane). Located in the lower right section of the Main Window, it is here that you
will use the mouse to perform such actions as moving the camera and manipulating regions of
interest. Two types of boxes should appear within the backplane representation (Figure 11):
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1. Regions of Interest
represented by either red
boxes (active) or magenta
boxes (inactive).

2. The camera field of view
represented by a blue box.

See also: Backplane representation
Active ROI ...... (Rgure 1)
33
Backplane ...........cooiiiiiii 36
Camera Field of View .........ccooovvivviinnnnn. 105
Inactive ROI .....ovveiiiiiieee 58
Backlight

The backlight is the fluorescent tube which illuminates the backplane and, consequently, any
translucent imagery therein. It can be adjusted in the Histogram Window (Figure 12) by
moving the “Backlight” bar between O and 4, where 4 is the brightest setting and O is the

dimmest.
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See also:
Brightness .......ccooeviiiiiiiiiiiie 37
HIStOgram ........cccoeviiieiiiiiiiiii e 56
SNULET ..o 83
Brightness

The brightness control is used to increase or decrease the amount of light transmitted from
the backlight to the camera, thus affecting the overall brightness of the resultant image.
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Adjusting the brightness causes the entire histogram to shift either to the right (brighter)
or to the left (dimmer), without having much effect on the range of the gray levels used.

Bad Histogram
(Figure 12)

This histogram shows a less than ideal match between the image intensities and the gray
levels representing the image pixels. Note that no pixels have a gray value of O or 255, thus
reducing the radiometric range. To correct this, increase both the brightness and contrast.

Adjusting brightness

To properly set the brightness, first make sure that ‘Resolution’ in the “Current Scanner
Settings” area is set to the resolution at which you will be scanning. Move the camera field
of view to the brightest parts of the ROI and look at the histogram. Adjust the histogram
so that there are just a few pixels with a gray value of 255. If you see a spike at 255, decrease
the brightness. If the brightest pixel has a value less than 255, increase the brightness. It
is a good idea to check several bright areas on the ROI,and set according to the brightest
one. Be careful to look only at the film and not include any of the empty backlight in the
camera field of view. It is also best to set your histogram using only detail within the ROI.
Detail outside of an ROI will not be scanned, and consequently you would not want to rely
on it for your adjustments.
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The Backlight Bar and the Shutter Bar (Figure 12) adjust the brightness registered by the
camera. The backlight bar changes the intensity of the backlight and has settings from 0 to
4, with 0 being the dimmest and 4 the brightest. Brightness can then be fine-tuned by
changing the shutter duration, which affects the amount of time that the camera is exposed
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to the image. Values may vary between .000 to .999, with .000 being the least exposure
time and .999 being the most exposure time.

This system does create a certain overlap between different backlight/shutter combinations.
For example, theoretically, on certain film, Backlight 3, Shutter .750 (3.750) will produce
approximately the same results as Backlight 4, Shutter .250 (4.250). However, this is not a
simple redundancy. If the film itself is very dark, a brighter backlight will result in a more
effective grab by the camera. If the film is very light, better result may be obtained by
limiting the backlight and increasing the shutter for a longer exposure time.
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Saturated histogram
(Figure 13)

This histogram represents an image that is too bright. Note the big spike at 255 (the highest
gray value). This is known as “saturating white”, which will result in clipping, whereby bright
areas of the image with different brightness levels will all be represented by 255, thus
destroying the detail in those areas. To correct this, decrease the brightness. The contrast
control may also have to be adjusted, either up or down.
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Good histogram
(Figure 14)

Figure 14 shows the effect of decreasing the brightness. Note that as the right hand side of
the histogram is moved towards the left, or away from 255, the left hand side has moved to
the left as well. This is the proper setting for the brightness.

See also:
0 Backlight ........ccoovviiiiiiiii e 37
:g E COoNrast .....oooeveiieii e 46
:'tl E HIStOgram .......cccveviiiiiiiieie 56
P SHULET oo, 83
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Tip: When performing high resolution scans, it is
often easiest to locate the brightest and darkest areas
of an image at a low resolution, centering this area in
the camera field of view (as seen on the image

monitor) then changing to your scanning resolution.
Also, in order to save time when performing color
scans, try locating these regions first in monochrome
and then select color.
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Tip: Longer shutter duration may cause a slight
increase in the amount of time it takes to perform a
scan. For speed purposes, a brighter backlight setting
and lower shutter setting may be preferred. Therefore,
although theoretically settings of 3.5 and 2.8 would
produce the same histogram, 3.5, with a shorter
shutter duration and brighter light, would be
preferable.

Tip: For best results, film should be handled only with
cotton gloves and kept in protective sleeves or film
canisters. Scratches and dirt on the film may cause
misleading spikes in the histogram which could affect
how you set your radiometry.
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Calculate

The selection of this button in the Acquire Centers Window will result in the center of a
centrally symmetric point being located and digitized.

See also:
Acquire Centers .........oooeevvvvveeeiviiiiieeeenn 29
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Calibrate

The VX4000 relies on software calibrations to maintain its high level of geometric and
radiometric accuracy. The hardware component of the VX4000 is extremely durable, yet in
the event of damage, or even just over time, it may be necessary to perform calibrations. If
scanner errors or degraded scans are experienced, contact Vexcel Imaging for calibration
advice or refer to the VX4000 Installation and Maintenance Manual.

Camera

Moving the camera

1 Position the mouse pointer within the backplane representation (it is usually best to
position the pointer in the dark blue box, which represents the camera’s field of view)
and hold down the right mouse button while moving the mouse. This grabs the camera
and moves it to a new location within the backplane. As you hold down the button and
roam, the camera field of view is displayed on the image monitor in "live" mode.

Tip: |If things are too dark on the image monitor
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Monochrome Mode. (ie. If the Monochrome Mode
Backlight Bar in the Histogram Window is at “l”,
increase it to “2” or “3”).

2 Release the right mouse button when you are satisfied with the new camera position.
As soon as you release the mouse button, the camera grabs and displays the image on
the image monitor using the Current Scanner Settings.
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Tip: For more precise movement, hold down the
<Shift> key while moving the camera. Release the
right mouse button before releasing the <Shift> key.

Moving the mouse cursor inside the camera field of view will cause the cursor to appear on
the image monitor. The cursor will appear to slow down in the backplane representation,
but will move at normal speed on the image monitor. Especially at high resolutions, the
cursor may appear to be trapped in the camera field of view, and the mouse will need to be
moved a comparatively great distance to exit the camera field of view.

See also:
Backplane Represention . ............... 36

Color

This function, located in both the “Current Region of Interest Settings” area and the
“Current Scanner Settings” area, allows the operator to toggle from Monochrome to Color
for scanning color imagery. Color scanning on the VX4000 is made possible by the use of
red, green, and blue filters which are placed in the optical path. An 8-bit monochrome grab
Is performed through each filter, resulting in a 24-bit color image.
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To set up color scans

When Color has been selected in either or both of the “Current Region of Interest Settings”,
or “Current Scanner Settings”, the User Interface will contain three Contrast and Brightness
input fields. These settings can be adjusted manually by placing the desired values in the
fields, or by using the histogram.
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Color histogram
(Figure 15)

When adjusting the radiometry for color images, a histogram for each band is displayed
(Figure 15) to facilitate the setup process.
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Setting the “Brightness” and “Contrast” controls becomes a little more complex when
working with color images. As in monochrome imagery, you would wish to set your
histogram to use the maximum number of gray values. With color however, you must also
concern yourself with achieving a proper balance between the colors. This may be done by
locating the whitest area on your image and moving the camera to that location. Since pure
white consists of an even balance between red, green, and blue, the goal is to align the
highest (brightest) peak of each band. To achieve this, you will often have to set your
histogram such that one band has pixels at 255 (as in monochrome setup), while the other
bands may not. It is common for the three brightness settings to be different.

To set the contrast, go to the darkest area and proceed as with a monochrome image,
stretching the histogram curve to the left for each color band. It is, however, important in
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color imagery that you do not stretch one band significantly more than the others, as this
may unbalance the colors and “exaggerate” detail which is not apparent in the image.

See also:
Brightness ......ccooovviiiiiiiiiiin e, 37
COoNrast .......oovvieieiiee e 46
Histogram ........ccoooviiiiiiiiicic e, 56
Color Type (Monochrome/Color) ............ 106

Constraint Point

Currant Soamar Sattinge I
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Examples of constraint points
(Figure 16)

Constraint points “lock” a dimension on an ROI. They are represented by an “x” in an ROI
corner. Like ROIs themselves, active constraint points are red, while inactive constraint
points are magenta. An ROl will appear initially with the top left corner constrained. If
another constraint point is placed adjacent to the existing one and “Size in pixels” has been
specified under ‘Set Preferences’ in ‘Options’ on the menu bar, then the ROI will not be able
to be moved in certain dimensions. To remove a constraint point, make it the active
constraint point (by clicking on it with the left mouse button) then select ‘Release Point’
under ‘Edit’ on the menu bar. In circumstances where you wish to delete multiple constraint
points, you may select ‘Delete Rectangle’ under ‘Edit’ on the menu bar. This has the effect
of removing the ROI from the Backplane Representation while keeping its name and
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settings. The ROl may be placed again by clicking the left mouse button within the
backplane representation, and you will notice that only one constraint point will remain.

See also:
Delete Rectangle ..........ccoocoiiieviiineeennnnn. 97
Edit MENU ..ocviiie e, 95
Release Point ........coooviiiiiiiiiiicee, 96
Rubberbanding ........c.ccooiviiiiiii 82
Contrast

Selecting this option in the vxscan Main Window will open the Histogram Window. Contrast
is a radiometric adjustment which must be performed prior to scanning. The contrast
control may be thought of as the "stretch” factor. Contrast is always set after the brightness
has been properly adjusted. To set the contrast for an image, use the resolution you will use
at scanning time. Move the camera field of view to the darkest parts of the image and look
at the histogram.

Adjusting Contrast

Contrast may be adjusted using the Pivot and Slope Bars on the left side of the Histogram
Window. The Pivot Bar determines from what point on the gray scale the histogram will be
stretched. For example, if the Pivot Bar is at 153, then the histogram will stretch from 153 to
0 and 153 to 255. If the Pivot Bar is set at 255, than the histogram will stretch from 255 to
0.
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It is recommended that the histogram first be properly adjusted using the brightness settings
such that the histogram shifts up to allow a few pixels with a gray value of 255. Then, use
contrast to stretch the histogram towards O.

Slope determines the amount that the histogram will be stretched from the pivot point. At
500 there will be no stretch. .000 to .499 will compress the histogram, with .000
compressing it the most, and .499 the least. .501 to .999 will expand the histogram, with
501 expanding it the least and .999 the most.
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Figures 17-19 show the effect of stretching and contracting the histogram from the midpoint
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Good histogram
(Figure 17)
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Over-contracted histogram
(Figure 18)
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Over-stretched histogram
(Figure 19)
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Setting the Slope Bar to a value less than .5 will compress the histogram so that areas that had
a gray value will lose some or all of their value. Thus, setting the Slope Bar to a number less
than .5 actually shrinks the output gray value range and would rarely be desired.

Tip: It is often simplest to set the Pivot Bar to 255.
This causes stretching to occur only in one direction
(from 255 to 0). If your brightness has been adjusted

properly, then you should already have an appropriate
amount of pixels at 255, and stretching in that
direction would cause loss of detail.

See also:
Brightness ......ccooovviiiiiii e, 37
Histogram ........ccooovviiiiiiiiiiii e, 56
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The Windows NT PC which runs the VX4000. It is on this system that vxscan will be run.

Default Photo File

When the vxscan application is first started, parameters saved in a default Photo File
(default.ph) will be loaded. This default file may be used to store scanning parameters that
are used often. For example, if you typically scan images that use the same “Resolution”,
“Contrast”, and “Brightness” settings, these settings may be stored in the default.ph file.
This will save time when you start the set up of each image. Because default.ph is an actual
.ph file, it must be saved just as you would save any other photo file. The default.ph file
must be located in the current working directory from which you run vxscan to be used as a
default file, otherwise, vxscan uses the system defaults which are stored in the code.
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Npte: The default photo file saves the settings in the
“Current Region of Interest Settings” area at the top of
the Main Window, as opposed to .vxscanrc, which
saves the settings in the “Current Scanner Settings”
area.

Apte: Loading a .ph file changes the current ROI to
be the first ROI in the .ph file, and changes the ROI
settings appropriately, but does not affect the Current
Scanner Settings. The .vxscanrc file specifies the
Current Scanner Settings when the vxscan Main

Window first comes up. g )
i
Z>
30
See also: ¢z> o
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PhotO File ..o 73
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Density

Selecting this option, which is located in both the “Current Region of Interest Settings” area
and the “Current Scanner Settings” area, will result in scans being performed in density
space as opposed to intensity space. For a more detailed description of the difference
between density and intensity, see Intensity. As a general rule of thumb, if you have very dark
or detailed imagery, or wish to bring out more dark detail, scanning would be best
performed in density mode.
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See also:
Intensity . ............ .. .. .. ..... 59

English

Option for “Units:” in the Preferences Window under ‘Options’ on the menu bar. Resolution
will be displayed in dots per inch (DPI) and ROI dimensions will be displayed in inches.

See also:

Fiducial

Fiducials (Figure 20) are reference marks present on much imagery. They are, in most cases,
located on a mask in the optical path of a camera. When a photograph is taken, the fiducials
will appear on the film along with the image. Since the relative locations of the fiducials are
known through camera calibration, they may be used along with values pertaining to the
geometry of the airplane (in the case of aerial photography) to produce accurate information
regarding the physical surface photographed.

Nk BB . s Tan' e
AN HE &@LJ

(Figure 20)
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On the VX4000, fiducial coordinates may be recorded and stored in a Photo File for future
extraction and use. Their locations will be stored in scanner coordinates, So a conversion
must be undertaken to put them into a usable coordinate system. They may be saved by
using Acquire Points.

See also:
Acquire Points .......ccccooeviiiiiiiiiieeeee, 31
Interior Orientation . ............... 61
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Fixed ROI

A Fixed ROI is an ROI which is not moveable through automatic means, and would be
designated as such within the Acquire Points window. A fixed ROI will not reposition and
can not be used for Frame Relative ROIs.

See also:
Acquire POINES .....cooviiiieiiiiiiiiiiiii e 31
Frame Relative ROl .....covevieiiiiiiiiiaa, 53
Formats

The following formats are supported on the VX4000:
1 No Format

This option stores the raw data tiles but does not format them together. The Vexcel Imaging
vxformat program will have to be executed manually if you wish to produce a final, formatted
image. These raw data tiles usually have a name like: *.w for monochrome images or *.[rgb]
for colored images.

2 BIF

(=
m
J
£
!
(®)
2
7]

%® sTiviaqg

BIF stands for binary information file. It contains a raw binary image file and an ASCII
header file which describes the file name, width and height of the image and so on. This
image format is row major, band interleaved by pixel and one byte per pixel in RGB order.
The output raster image files have a suffix .bif.w for monochrome images or .bif.rgh for
colored images. The ASCII header files have a suffix .bif.

3 BSF

BSF is a band sequential file, one byte per pixel image format. There is no ASCII header file
for this image. The output image file is just one or three raster image data files with a suffix
.Jbsf.w for monochrome images or .bsf.[rgb] for colored images.

4 BIP

BIP stands for band interleaved by pixel. It is a row major image format, one byte per pixel
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in RGB order. There is a ASCII header file that contains ancillary data about the image, such
as the number of rows and columns in the image, etc. This header file has a suffix .hdr. The
output raster image files have the suffix .bip for both monochrome and colored images.

5. COT Row

COT stands for continuous tone image format. We support only COT type 1 formats with
minimum header size (row major). These formats are proprietary image formats of
Intergraph Corporation. There is a fixed-size header followed by ordinary raster data. The
output image files have a suffix .cot for monochrome images and _[rgb].cot for color
images. There is no separate ASCII header file required for this image format.

6. Imagine
The Imagine format supported by the VX4000 is the proprietary format of ERDAS Imagine.
The files have the extension .img. No ASCII header file is required for this format.

7. SunRaster

SunRaster files are used by Sun Microsystem workstations. They are also now supported on
non-Sun workstations. Its raster image file has a suffix .ras with a binary header for both
color and monochrome images. Each line of the image is rounded up to a multiple of 16
pixels. There is no separate ASCII header file required for this image format.

8. TIFF
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Tagged Interchange File Format (TIFF) is designed to be a universal raster image format. Its
image file contains a header and image data. Image data is stored through a simple scanline-
based interface that works with images organized as strips (row major). The output image
files are named with .tif for both color and monochrome images.

9. Tiled TIFF

Tiled TIFF format allows the user to select/specify a tile size for viewing on 3rd party
platforms which support tiled TIFF. Three tile size options are given, or you may contact the
Customer Support Department at Vexcel Imaging for information on specifying your own
tile size. There are several settings in the VX4000.ini file which related to this format:
RamCacheMemory TileGroupMemory OutputTileSize=
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Additional information can be found on these settings in the Installation and Maintenance
manual.

For all image formats mentioned above, there will be an output region header file supplied
with a name suffix .rh. All output files, such as image data files, .rh files, and ASCII header
files (if applicable to that image format), will be placed in the ROI subdirectory specified in
the ROI input field in the Main Window.

See also:

VXFOIMAL e,

Frame Relative ROI

vxscan supports repositioning of ROIs with respect to reference points on the film. This
means that ROIs established when the film was previously in the scanner may be easily
moved to the proper position when that film or similar film is placed in the scanner again
at a different location.

Template Photo Files

A Template Photo File must contain reference so that the ROI, or ROIs, can be correctly
repositioned on the next image.

Generating Template Photo Files

1

2

From the menu bar, select ‘Edit’ = ‘Acquire Points’.
Click Template
Use the left mouse button and click on the point to

be digitized, at least one point (the top left fiducial
is recommended). Then click OK.
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Acquire Points Window
(Figure 21)
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4 There can be many ROIs saved in this template file but all ROIs to be repositioned must
be saved in Relative Mode. The Absolute/Relative button is in the “Current ROI
Settings” area of the vxscan Window.

5 From the menu bar, select ‘File’ > ‘Save As’ to save your template.ph file.
Repositioning ROIs

1 From the menu bar select ‘File’ > ‘Open’ > ‘Photo’ and open your template.ph file. All
ROIs saved in the template file will open on the same location on the backplane that
they were originally saved.

2 Move the camera over the new point (for example the top left fiducial) you want to use
as the reference for the new image location.

3 From the menu bar, select ‘Edit’ - ‘Acquire Points’ and verify that Reposition has been
selected. If the ROIs were not saved in Relative Mode, than Reposition may be greyed
out and only Fixed ROI will be available. In this case, go back to step one under
Generating Template Photo Files and be sure to save all ROIs in Relative Mode

4 Move the cursor into the camera field of view in the backplane representation, watch
for the cross hairs (+) in the image monitor, place the cross hair on the desired point
and click the left mouse button. Note in the image monitor that a green cross hair is
placed at that location.
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8 Click OK in the Acquire Points Window and your ROIs should be repositioned. Update
the image monitor to verify the repositioning by clicking on the right mouse button
while in the backplane representation.

See also:
Acquire POINS .......ceiiiiieeeiiiieeeiiiiii 31
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Frame Setup Window

The Frame Setup Window is opened when the operator desires to use the Interior
Orientation Transform. In this window a “Frame Type” will be designated and the path to
the camera database file will be verified. The bottom portion of the window allows the
operator to adjust the radiometric setting which will be used when looking for fiducials.
The rotation, exposure type and mode (density/intensity) may also be designated at this

time.

2 Frame Setup 3

Frame Tupe: Tiefault Frame Frame Size {mm}:
Fault F ! !
[lefault Frame
] [ [Belete] g |§230‘oooo |§230‘0000

leika_frame

Camera Files

I}Files\uexcel\db\testroll,cam

Fiducial Finding Exposure;

Resolution: Io12,0000 Expozure Type: Hegative -Jl
Brightness: Poz,zon Rotation: | 180 Degrees =1 | Eﬁd Eancell

Contrasts 128, 9000 Modes | Marmal .Jl
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The Frame Setup Window

(Figure 22)
See also:
Frame Setup Window .. ........ 102
Interior Orientation ............ 61
Gray Level

For the VX4000, the gray level is an 8-bit number representing the shade of a pixel. This
means that gray levels may fall between O, which is 100% black, and 255, which is 100%
white. In color scanning, three 8-bit monochrome pixels are accumulated by the camera for
each pixel location, then formatted into an image giving 24-bit color.
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Height

The height parameter is located in the “Current Region of Interest Settings” area and
indicates the height of the active ROI in both mm/inches and pixels. Depending upon your
settings in the Preferences Window, at least one of the input fields will allow manual
changes to its values.

See also:
Auto Calculate Dimension ...........cc.......... 35
UNIES o, 84
Histogram

This option in the “Current Scanner Settings” area will bring up the Histogram Window
(Figure 23) which will display a histogram for the region currently within the camera field of
view. This window may also be brought up by selecting ‘View’ - ‘Histogram’ on the menu
bar, by clicking Contrast, or by clicking Brightness.
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Histogram Window
(Figure 23)

With the Histogram Window open, you will see two slider bars on the left which affect

contrast, two slider bars on the right which affect brightness, three beige input fields along
the bottom which will display information about particular gray levels, and a large field in
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the middle which displays the histogram curve. Within this large middle field, the available
256 gray levels are represented along the x-axis, and the number of pixels is represented
along the y-axis. By clicking with the left mouse button within this field, data pertaining to
that gray level is displayed in the input fields along the bottom of the Histogram Window.
You will see the specific gray level you selected, the number of pixels at that level, and the
percent of overall pixels represented by that number of pixels. Clicking and dragging will
enable you to move the pointer along the histogram so that the information can be checked
at any location.

See also:
Brightness ......ccooovviiiiiiiiiiecce e, 37
CONIFAST .o 46
Host

Formatted images may be written to remote hosts. There are two categories of remote hosts
that may receive formatted images.

Unix

Hosts using unix filesystems must be running the vexcel remote-1/0O server. To send a
formatted image to a unix-based host, add the name of that host to the TargetHosts line of
the [Formatting] section of vx4000.ini. This host name must also be visible to the instance
of NT running on the controller. The simplest way to accomplish this is to add the host
(along with its IP address) to the file \winnt\system32\drivers\etc\hosts.
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Once the host name has been added to vx4000.ini, it will appear on the Hosts push-button
menu on the vxscan Main Window the next time vxscan starts. To send an image to a remote
host, select the host on the push-button menu and enter the full path to the target directory
in the ROI input field. ROI paths specified for Unix remote targets are not checked before
scanning commences.
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For more detail on setting up an RIO server, or if you are running 3 party PCNFS software,
please contact a Vexcel Imaging Customer Support Engineer.

Windows95 & NT

Sending images to other NT or Windows 95 hosts does not require that a remote-I/O server
be running on the target machine. All that is required is that the target drive be mapped to
a drive letter on the scanner controller. In the “Current Region of Interest Settings” area,
select Local on the host push-button menu, and enter the full path to the target directory in
the ROI input field, beginning with the drive letter. ROI paths specified for NT and 95 are
checked before scanning commences.

IDAS

Integrated Digital Aerotriangulation System, IDAS, is a Vexcel Imaging software package
which works directly with the VX4000 and Automated Film Drive to increase productivity
by decreasing the time required to perform aerotriangulation. For more information
regarding IDAS, please contact Vexcel Imaging.

See also:
Automatic Film Drive .......ccoveeiieiiiinn. 36
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Image Monitor

The monitor attached to the controller which displays the camera field of view as you roam
in “live mode”.

Inactive ROI

Represented as a magenta box on the backplane representation, inactive ROIs are listed in
the List of Regions but do not have their values immediately visible in the “Current Region
of Interest Settings” area.

See also:
Active ROI ..o 33
Backplane Representation...................... 36
List of Regions ...........ccovvvviiiiiviiiiiiieeeee, 78, 117
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Inches

Unit of measurement used when “English” is selected under “Units:” in the Preferences
Window. “Resolution” will be displayed in dots per inch (DPI).

See also:

Intensity

Selecting this option, which is located in both the “Current Region of Interest Settings” area
and the “Current Scanner Settings” area, will result in the scan being performed in Intensity
space as opposed to density space. Generally, if you have very light imagery, or low detail
(flat) imagery, intensity mode may work best.

To understand the difference between the intensity and density settings, some common
terms need to be reviewed. When film is processed, areas of the image receive different
amounts of illumination and thus have varying degrees of blackness. The blackness of a
negative, or its light-stopping power, can be expressed numerically in the following different
ways:

Transmittance
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Transmittance is the ability of a material to allow light to pass through it and is usually
expressed as a fraction or a percentage: what comes out divided by what went in. For
example, if 100 units of light are directed at a material and 90 units actually pass through,
the transmittance of the material is 9/10, or 90%.

Opacity

Opacity is just the opposite of transmittance. Opacity refers to a material's ability to block
or absorb light. It can be found by dividing 1 by the material's transmittance and its value
can never be less than 1. Using the example above, the opacity of the material would be 1.11.
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Density

Density is the common log of opacity. For example, if a material transmits 25% of the light
that strikes it, 25% is equivalent to the fraction of 1/4, the reciprocal of which is 4. The
opacity of the material is therefore 4, and the density is the log of 4, or 0.604. Here are
some examples to help clarify this relationship.

CLEAR %Transmittance Opacity Density

100 ... Lo 0

75 133 o 0.124
50 . 2 0.3
333 3 0.48
20 ... T 0.7

0 .o 0 . 1

D 20 .. 1.3

2 50 . 1.7
Lo 100 ... 2.0

DARK

Density is the unit used most often in sensitometry. Like opacity, it increases with increasing
blackness, but has the following advantages:
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1) The numerical value of density bears an approximately linear relationship to the amount
of silver or image dye present. For example, if the amount present in an image of density 1.0
is doubled, the density is increased to 2.0. The opacity, however, increases from 10 to 100,
or tenfold. Thus, calculations between several optical components that are multiplicative
because they use transparency or opacity, become additive when using optical density.

2) The final aim is to relate the tones of the print to those of the subject. Blackness in the
print depends on the way the eye assesses it, and is therefore essentially physiological. The
law governing the effect produced in the eye when stimulated is not a simple one, but over
a wide range of viewing conditions the response of the eye is approximately logarithmic.
Thus, if we examine a number of patches of a print in which the density increases by equal
steps, the eye accepts the steps as of equal blackness increase. From this point of view, a
logarithmic unit is the most satisfactory measure of blackening.
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The vxscan intensity setting is essentially transmittance and the vxscan density setting is the
density value, or log transform of opacity. So, which setting is appropriate? Use density to
accentuate structures within the darkest areas. Use intensity to accentuate structures in the
brightest areas. Your choice also depends on the final film writing process; use density if
your printing setup assumes density data.

See also:
DENSItY ..coovviiiiiiecee e 49

Interior Orientation Transform (10T)

Interior Orientation is the process of relating the fiducial markings from scanned images to
those calibrated on the aerial camera. The fiducial markings from the scanned images are
transformed mathematically and compared to the calibrated ones. The results of the
transformation, which are written to the .ah file, can be evaluated by a third party software
package. This saves time in post processing since the Interior Orientation transformation
has already been calculated.

In order for vxscan to perform Interior Orientation the user must specify a Camera Database
file. A Camera Database file contains the name of the camera, number of ficudials,
calibrated X and Y coordinates, and the fiducial mask file name. A fiducial mask must be
created for each type of fiducial on the camera. A library of fiducial masks for the most
common aerial cameras is located in Files\Vexcel\db\fid_masks.
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How 10T Works

The Interior Orientation Transform will transform points between image space (which is

pixel based) and camera space (which is millimeter based). For every ROI that is scanned,
the location of the fiducials will be written to the .ah file.

Vexcel Scanner
Position Space X (um)
Y (mm) -
A
R s X (pb0)
# = xm) “
o &
Y(pix) Y
Y
Y (um)

= Camera Space to Image Space

Image Space to Camera Space

Diagram showing the relationship between image and camera space
(Figure 24)
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Using 10T

There are 4 basic steps involved in using 10T:

1. Enable IOT

2. Complete the Frame Setup Window
3. Complete the Scan(s)

4. Check .ah file
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Step 1 - Enable 10T
1 Check to see if IOT has been enabled.

= From the Menu Bar click on ‘Options’ A sixth choice has been added: Frame Setup.
If this option is grayed out then IOT has not been enabled.

2 Enable 10T.

e From the Menu Bar select ‘Set Preferences’ to bring up the Preferences Window
(Figure 25). Click in the box next to “Enable Interior Orientation”. It is not necessary
to select OK as the ‘Set Preferences’ Window will accept the change and close

automatically.
[ Peataranees . H
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The Set Preferences Window
(Figure 25)

Note: To skip this step in the future, save .vxscanrc and the current settings will

become the default. The next time vxscan is started Interior Orientation will already
be enabled.
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Step 2 - Complete Frame Setup Window

1 Bring up the Frame Setup Window

e Select ‘Options’ from the Menu Bar. After Interior Orientation has been enabled

Frame Setup will be available. The Frame Setup window automatically appears when
Frame Setup is selected.

X Frame Setup

Framz Typet IE]JeFault Frame Frame Size {mm):

[Default Frame
Hddl Deletel 10T Frans

leika_frame

K ki

| 2300000 | 230, 0000

Camera Filey

I Afilestwexcel\dbhtestroll,cam

Fiduzial Finding Exposure;

Resolution: Io12,0000 Exposure Type: MNegative = |

N I
05 g Brightress: I: 2,2000 Rotation: | 180 Degrees =1 | M Cancel
N = "
=| |: Contrast: |;128,9000 Hodes | Mormal _||
< 2
[T The Frame Setup Window
o g (Figure 26)

2 Designate the Frame Type and any other information relevant to the current project.

e The Frame Setup Window is similar to the Frame Parameters and Frame Mounting
Windows used in vxphotolist.. Through this window the “Frame Type” will be
designated and the path to the camera database file will be verified. The bottom

portion of the window allows the operator to adjust the radiometric settings which will
be used when looking for fiducials. .

See Also
Frame Setup Window. ............. 55, 102

64



Details & Definitions

3 Save the settings

= Once the frame type has been selected, and any other changes have been made to
the Frame Setup Window complete, click on OK to save the settings.

Step 3 - Complete the Scan

1 Open the desired .ph file

2 Digitize a point (the upper left fiducial is recommended) and reposition the ROI. Using
the Quick Point Model is the recommended method.

3 Complete the setup for the scan by designating resolution, brightness, contrast and any
other settings that are pertinent to the current project.

4 Scan the Images(s).
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Note: Once the Interior Orientation Transform has been enabled, 10T E E
will be performed on all subsequent scans until vxscan is closed. = ﬁ
o
zZ @
See also:
VXSCANIC .« oot 86
phfile ... ... ... 73
Acquire points . ......... .. .. .. ... 31

Step 4 - Check .ah File

The .ah file is written to the same directory as the resulting images. View the contents of
the file to examine the validity of the results.

See also:
ahfile oo 34
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Local

Selecting this option in the “Current Region of Interest Settings” area, along with specifying
an ROI path which is local to the controller, will result in the scans being stored on the local
hard drive or a remote machine with a mapped drive as opposed to remote storage.

See also:
Remote Storage ........cccovvvviiiiiiiiiiiieiinee, 80
Region of Interest ...........c.coceiveviiieeennnnn. 76

Look Up Tables

A Look Up Table (LUT) is an ASCII (text) file that specifies how original or input gray values
(0-255) are mapped to output gray values (0-255). The file contains 256 lines of paired
integers separated by blanks or tabs. This file can contain optional comments, preceded by
a '#' sign as the first character on a line. It is recommended that the name of a custom LUT
end in ".lut' to aid in managing the files. The following is an example of a LUT file:

o3 2 # log LUT

0w 2 #

d E 0 0

2 13l

=1 2 50
3 63
254 255
255 255

In the example, the first two lines are comments. The next 256 lines specify a mapping
between input gray values such as 3, and the corresponding output gray value such as 63.

Because LUTs are tedious to create using a text editor, it is recommended that they be

generated by spreadsheets or other software. vxscan does not include tools to produce
custom LUTSs.
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vxscan allows a custom LUT to be associated with each
band (monochrome, red, green, and blue). If the Current
Scanner Settings in the vxscan Main Window are set to
Monochrome and Custom LUT is selected, then a file
selection window is displayed. This allows you to specify the
name of the custom monochrome LUT. If the Current
Scanner Settings are set to Color, you are prompted to enter
Custom LUTs for red, green, and blue. These LUTs may be
the same or different for each color (Figure 27).

After selecting the name (or names) of the LUTSs, the
display on the image monitor and histogram will reflect
the application of the LUT(s) to the image. Use of the
LUT(s) may be disabled/enabled by toggling between
Default LUT and Custom LUT. The LUT(s) may be
applied to the ROI by clicking Apply to ROI.

o Castnm Gneen LT

Filter
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B L tor ey Files
oompretead Lt

DF L Lt s Dt - oompresad, lut
ot . Lt
darbord . Lt
k2. Lt
darken . Lut
darben2 Bt
ek 7. lut

Salactian

CitF i leawmoom ] 'y

i 5 Fultar I Larcal | Halp |

Custom Green LUT Window
(Figure 27)

Because custom LUTSs are files, they can also be managed under ‘File’ on the menu bar. By
selecting on the menu bar ‘File’ = ‘Open’ = 'LUT’ = ‘Monochrome,Red,Green,Blue’, you
can load a LUT for each color channel. If a LUT has already been loaded for a given channel,
it can be closed and replaced. Selecting ‘File’ - ‘Close’ - 'LUT" - 'Monochrome, Red,
Green, Blue’ on the menu bar removes the association between a LUT and a color channel.

See also:

Open, Custom LUT ......ccoovviiiiiiiiiiin,
Look Up Tables .........cccoovevviieiiiineeennn,
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Note: If a photo file (.ph file) with custom LUTSs is
opened, you will be prompted to also open the
specified LUTs before scanning may be accomplished

Tip: When using custom LUTSs in color scanning, a
LUT must be open for each band (RGB). In the event
that only one band requires a LUT, the one2one.lut file
performs no mapping, and must be applied to the
other bands. This and all other Vexcel provided LUTs
are located in the directory c:\files\vexcel\lut.
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Tip: In the directory c:\files\vexcel\lut is an Excel™
spreadsheet file which contains values which allow you
to create your own custom LUTs. This tool is simple
to use, and will allow you to create LUTs for your
specific film type.
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LUTs

See also:
LookUpTables .................. 66, 108

Metric

Option for unit of measurement under “Units:” in the Preferences Window under ‘Options’
on the menu bar. Resolution will be displayed in um/pixel and ROI dimensions will be
displayed in millimeters (mm).

See also:

Main Window

The vxscan graphical user interface (GUI) will come up when vxscan is started. The
interface, which will be used for setting up and performing scans, consists of three main
sections:

Menu Bar - Contains commands for file manipulation, preference setting, ROl manipulation,
and system cleaning,
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Current Region of Interest Settings - Displays information regarding ROIls

Current Scanner Settings - Displays information about the image as seen on the image
monitor, as well as the placement of the ROIs.

See also:
Current Region of
Interest Settings .........cceveeveiiiiiiiiiiiinnns 113
Current Scanner Settings ............cceeeeeeee. 104
Menu Bar .......c.oooiiiiiiiii 90
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Manually Changing ROl Dimensions

In the center of the Main Window you will see two beige input fields, labeled “Width:” and
“Height:”. Change the value in each field to your desired dimensions and press <Enter>. It
may now become necessary to reposition the rectangle.

To place the ROI exactly where you want it, first, [T ]|
repeat the steps listed above. Then, use the left mouse |"==
button to select from the menu bar ‘Edit’ - ‘Delete
Rectangle’ (NOT ‘Delete ROI’). This will make the red
box in the backplane representation disappear, and el

your mouse pointer will now appear as an inverted “L” }Eise 46 mavlchan frukiurtantiag Hlashiad)
when it is within the backplane representation (but will # Sice 11 pamals

still appear as a cross in the camera field of view). On | & i f1iw e

the menu bar, select ‘Options’ > ‘Set Preferences’.
Within the Preferences Window (Figure 28), in the
section “Auto Calculate Dimension:” select “Size in
Pixels” (it may already be selected by default).

aba Lalcwlste Dheraiosd

Enable laterior Grsmiatim

Preferences Window
(Figure 28)

Click OK to close this window. Now move the pointer into the camera field of view, move
the cross that you see on the image monitor to the upper left of the region which you wish
to scan, then press the left mouse button to “drop” your region of interest rectangle. The
dimensions (relative to the backplane) of the red rectangle will be those you specified.
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See also:
Auto Calculate Dimension .........cccc.ou...... 35
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Millimeters. Unit of measurement used when “Metric” is selected under “Units:” in the
Preferences Window under ‘Options’ on the menu bar. Resolution will be displayed in
um/pixel.

See also:

Mounting an Image

Opening the backlight box assembly

To do this, lightly grasp the top edge of the backplane, which is directly attached to the
backlight box assembly, and push it away from you (VX4000 systems with the AFD also have
software switches to allow automatic opening and closing. Use of these are described in the
manual supplied with the AFD). Set the image between the backplane and the front plate of
glass, what we refer to as the reseau plate. Be sure to place the emulsion side of the image
towards the reseau plate (and therefore, towards the camera), as even the ~115um thickness
of the film could affect focus and geometry if the film is placed incorrectly.
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Emulsion testing

The emulsion side of film is often apparent as the “dull” side of the image, as opposed to
the “shiny” side. If you are unable to see a dull side, you may perform a scratch test in an
inconspicuous corner of the undeveloped portion of the image. The emulsion should be
easily scratched by a pocketknife or other sharp object.

Closing the backplane

Once the imagery has been properly placed, close the backplane slowly so as to not “slam”
the glass plates together. The backplane is supported internally with springs, so it should
clamp the image snugly between the glass plates. (It is recommended, however, that you
confirm tight closure by grasping either side of the backplane and lightly pulling it forward
if properly closed, forward motion should be so slight as to be imperceptible).
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Note: Do not confirm closure by grasping unevenly
on the top edge as this could result in the lower
portion of the backplane pulling away from the

reseau plate. This can lead to the possibility of bad
focus and projection errors.

Proper scanning attire

It is recommended that you use cotton gloves when handling imagery, not only to keep finger
prints off of your film, but to also keep them off the scanner’s glass surfaces. Also, it is
extremely important that you remove jewelry with diamonds (rings, watches, bracelets) any
time you may come in contact with the scanner’s glass surfaces, whether you are just
mounting images or cleaning the scanner. Scratches resulting from such contact could be
detrimental to the quality of your scans, and could also result in intermittent scanner failure.

See also:

Non Template
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This option on the Acquire Points Window specifies that the .ph file to which you save the
points you digitize will not be a template .ph file for use with Frame Relative ROIs.

See also:
Acquire POINtS ........cevviiiieeiiiieiiiiiiiin 31
Frame Relative ROl .....coevvvieiiiiiiiiiann, 53
Photo

‘Photo’ will be presented as an option when either ‘Open’, ‘Close’, or ‘Save’ is selected
under ‘File’ on the menu bar. If selected under ‘Open’, ‘Photo’ will present you with a File
Selection Window from which you will choose a Photo File to open. If selected under either
‘Close’ or *Save’, the currently opened and active photo file will be affected appropriately.
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Photo is also the text field which displays the name of the currently open and active .ph file.
This field is found in the “Current Region of Interest Settings” area of the Main Window.

See also:
Close, Photo .....c.coovvviiiic, 92
Selection WINAOW .........coeevviiiiiiiiniinnnn. 11
Open, Photo ....ccooviviiiiiiic e 91
SAVE e 93

Photo File (.ph file)

A Photo File is a text file in which the settings for a scan may be saved for future use. Photo
files will contain all information regarding placement of ROIs, the radiometry of the ROIs,
the scan resolution, and the locations of any point digitized with Acquire Points. The ability
to save photo files allows the user to save commonly used settings, which will allow future
scans to be set up faster. To illustrate, if a user commonly scans two 97x9”
(230mm.x230mm.) color negatives, a photo file may be saved with the two ROIs already set
as negatives and with approximate radiometric values. Therefore, when two color negatives

=)
are next scanned again, the photo file previously saved may be opened for the new scan. m .-_?I
Z >
See also: %' "
Close, Photo ........ccoueeeennnen. 92 Z
Default Photo File ............... 48

Tip: Save the most commonly used scanning parameters
in the default.ph file. This file is loaded when the scanner
first opens.
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Alpte: When multiple .ph files are open, only the .ph file
associated with the current ROI (highlighted in the List of

Regions) will be displayed

Pivot

This component of “Contrast” allows the user to select from which gray level the contrast
will stretch. The actual amount of stretch is specified by the Slope Bar in the Histogram

Window.
See also:
contrast .....ooviiiiiii 46
" Histogram ..........ccceeeevneeeeeeen. 56
3z SIOPE e, 84
N =
4 E
i Pixels
W
R

“Pixels” is the dimension label for two input fields in the “Current Region of Interest
Settings” area, indicating the width and height of an ROl in number of pixels. Depending
upon your Auto Calculate Dimension, these dimensions may be manually alterable.

Pixels are also the smallest component of the scanned image. It is a square of uniform gray
level represented by an 8-bit number.
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See also:
Auto Calculate Dimension ... 35

Quick Point Model

The Quick Point Model provides a simpler method of repositioning points when a template
photo file is loaded. To use this feature, the following conditions must be met:

» The current photo file must be a template.

» The current photo must have at least one relative ROI.

» The current photo must have at least one previously digitized point which
has not been digitized during the current session.

Activating Quick Point
There are two ways to access the Quick Point Model. From the menu bar, select ‘Edit’ #
‘Quick Point’. A Hot Key has also been created for this function. Pressing ctrl k on the right

side of the keyboard will also activate Quick Point.

Once Quick Point has been activated (by either method) the Quick Point Pop-up window
appears.
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X Quick Point E
| Cancel I

Quick Point popup Window
(Figure 29)

This window informs the user that the Quick Point Model has been acitivated.

Using Quick Point

Quick Point works in a similar manner as Repositioning the ROI described in the Frame
Relative ROI Section (pg 53- 54), however it requires fewer steps.
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1 Activate Quick Point

2 Open a .ph file which contains a relative ROI template.

3 Digitize the upper left fiducial. The ROI will automatically be repositioned. It is
not necessary to open the Agcuire Points Window or to click on OK.

4 Additional points can be digitized if desired, however digitizing the upper left
fiducial is generally considered sufficient.

5 Right click on the image in Liveview to verify that the ROI is positioned

accurately.
6 Click on Cancel or press escape when there are no more points that need to be
repositioned.
See also:
Relative ROI',,,,,,,,,,,.,53
Acquire Points ,,,,,,,,,,31
Radiometry
For VX4000 purposes, radiometry refers to the “Brightness” and “Contrast” settings, which
» would be manipulated to produce an ideal reproduction of an image.
¥
= E See also:
E = Brightness .............cc..ooo 37
=¥ Contrast ......cccceeeeveevnvneennn... 46

Region of Interest (ROI)

Before a scan may be started, at least one region of interest must be specified. These
regions indicate the area you wish to have scanned. Only the area you specify will be
scanned, everything else in the Backplane will be excluded. Once scanned, these regions are
stored in sub-directories that are created using the file name specified in the ROI input field.
This subdirectory is where tiles, information files, and formatted images are stored. For
example, if you specify c:\images\atlanta in the ROI text field, an image subdirectory called
atlanta is created under the directory c:\images. c:\images must already exist and have write
permissions. The scanned regions are given file extensions to specify the type of image file.
In the above example, if Tiff was specified as the format type, the final image file atlanta.tif
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will be present in the subdirectory c:\images\atlanta. vxscan uses the default ROI directory
name, Untitled, until you supply one. If you decide not to supply an ROI file name and use
the default name of Untitled, a directory called Untitled is created in your current working

directory when you scan.

See also
ROI o 116

The prompt_popup Window
(Figure 30)

Note: Images can become very large, and
scanning in color requires three times the

amount of disk space as a monochrome image,
so select directories accordingly.

%® sTiviaqg
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To name the current region of interest,
1. Click on the ROI input field to open the window where you will change the ROI name.
Use the <Backspace> or <Delete> keys to delete any existing name such as "Untitled”

that may already be in the input field.

2. Type an absolute path name (if different than the directory in which you are working)
followed by the new directory name for the region of interest. The name appears in the
List of Regions on the right when you click outside the input field or press <Enter>.
vxscan checks to see if you have write permission for the given directory.
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List of Regions

Within the “Current Region of Interest Settings” area, the list of regions displayed on the
right are either ROIs that you have created or ROIs contained in an open photo file. If you
have more than one photo file opened, all of the regions from all of the photo files are listed.

File Naming Conventions

Although you provide the photo file and ROI names, vxscan appends certain file extensions
when storing the scanned images. Every scanned ROI is assigned a region header file using
the extension .rh. Every raw tile is a file which has its tile number appended. For example,
atlanta.nnmm.w, where

nn = tile number in x (across)
mm = tile number iny (down)
W = the color channel (monochrome in this example)

In the example above, a monochrome image has the extension .w appended. When you
select color scanning, the three color bands - red, green, and blue - are stored in separate
files as tiles. Color image tiles have the extensions .r, .g, and .b appended. When formatting
is complete, these individual tiles will no longer be present, and only the final image file and
its region header (.rh) file will be present in the ROI subdirectory.
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For example, a monochrome scan in a BSF (band sequential file) format would have the
following files:

atlanta.rh
atlanta.bsf.w

The following example is a color (RGB) scan in BSF format:
atlanta.rh
atlanta.bsf.r

atlanta.bsf.g
atlanta.bsf.b
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If scanned in tiff format, the above example would produce the following files:

atlanta.rh
atlanta.tif

Manipulating ROl Dimensions

The dimensions of a ROl may be changed many different ways. First, you may enter an exact
dimension within the width and height input fields. At least one field should be alterable,
depending upon how you set up your Auto Calculate Dimension. When an ROI has only one
constraint point in its upper left corner, its location in the backplane may be changed by
“grabbing” the upper left ROI corner with the left mouse button, then relocating the ROI.
Also depending upon the Auto Calculate Dimension, the ROI may be relocated despite the
number of constraint points, or the dimensions of the ROl may be changed dynamically
using “Rubberbanding”.

Typically, the simplest way to properly place an ROI is to place the upper left corner of the
ROI where you would like the upper left corner of your scan to be, then use rubberbanding
to drag the lower right corner of the ROI to the lower right corner of your desired scan area.
This may be easier to accomplish at lower resolutions. Once the ROI has been placed you
would need to switch back to your scanning resolution before adjusting the radiometry.
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See also:
Auto Calculate Dimension ... 35
Backplane Representation .. 36
Rubberbanding ................... 82

Relative

This option would need to be selected when placing a Relative ROI for use with the Frame
Relative ROI method. Relative ROIs may have their positions dynamically updated, as
opposed to Absolute ROIs, which are static.

See also:
Frame Relative ROI ............ 53
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Remote Storage

Images may be stored on remote filesystems once formatting is complete. Click on the Hosts
button in the “Current Region of Interest Settings” area and select the name of the remote
filesystem host. Specify the path to that filesystem within the ROI input field.

See also:
Local ...oovveviiiiieii 66
Region of Interest................ 76
Reposition

This option in the Acquire Points Window will allow for the dynamic repositioning of a
Frame Relative ROI.

See also:
Frame Relative ROI ............ 53

Reseau

The reseau is an extremely fine grid which is etched into the back side (away from the
camera) of the forward piece of glass. It is etched at a depth of 0.75um, and is visible only
when illuminated from the side by the reseau lamp, which is embedded in the Backplane
assembly. The reseau is what allows the VX4000 to consistently maintain accuracies greater
than 1/5 pixel. It is established as the focal plane (which is why it is important that the
emulsion of an image be against the reseau), and is used as a reference during calibration.
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See also:
Clean ......cccovvevviiiiiiiieein, 99
Mounting an Image ............. 71
Reset

Found on the bottom of the Histogram Window, clicking Reset returns the contast values to
255 for the pivot point and .5 for the slope value.
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Resolution

In its standard configuration, the VX4000 series of scanners support resolutions from
7.5um/pixel to 120um/pixel. The desired resolution may be specified manually by typing it
in the “Resolution” input field (unless resolution is specified as your Auto Calculate
Dimension), or a resolution slider bar may be opened by clicking Resolution.

See also:
Auto Calculate Dimension ..35

Changing Resolution using the Resolution Window

Using the left mouse button, click Resolution in the “Current Scanner Settings”  [EEE==Is
area in the Main Window. The Resolution Window (Figure 31) with a slider bar 28
will appear which allows you to use the mouse to change resolutions. When
you change the resolution, you will hear the scanner adjust to the new settings.
Once it has changed to the new resolution, you will notice that the dark blue
box in the backplane representation has changed size. Also, if the image which
you mounted is within the camera field of view, you should see a larger or

=]
smaller portion of that image, depending on whether you increased or i m E
decreased the resolution. I Z :T_>'
=4 r
4
o
See also: Z Qo
Moving the camera ............42
Camera Field of View ......... 105
[E=]
Resolution
. . Window
Changing Resolution Manually (Figure 31)

This is often the easier way to change to specific resolutions. Using the left mouse button,
double click in the beige input field under “Resolution” in the “Current Scanner Settings”
area. Once you have succeeded in highlighting the value in this field, type in the desired
value (ie. “25”) and press <Enter>. You should hear the scanner as it changes resolution,
and see the dark blue box in the backplane representation change sizes.
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See also:
Camera Field of View ......... 105
Resolution ........ccoveeveveenn.n. 81

Auto Calculate Dimension ... 35

Rubberbanding

This term is used to describe the action of dynamically resizing a region of interest when
“Size in pixels” is selected as the Auto Calculate Dimension. When an ROI first appears, the
top left corner should be the only one constrained. At that time, grabbing on or near that
corner with the left mouse button will allow the position of the entire ROI to be changed. If
any other corner is grabbed, the ROI may be resized as opposed to moved. When a corner
is grabbed, a constraint point will be placed in that corner. Adjacent constraint points will
restrict resizing in a dimension, whereas if constraint points are placed diagonally to each
other, resizing is possible in both dimensions. This action of resizing by using the left
mouse button is referred to as rubberbanding.

See also:
o3 2 Release Point..........cccuueen... 96
o 2 Auto Calculate Dimension ... 35
:'tl E Constraint Point .................. 45
nc Manipulating ROI
w . .
=¥ Dimensions ...........cccceeuuunee. 79

Note: If in Rubberband Mode, all points on the rectangle

except for the upper left must be released before the rectangle
can bemoved without changing its size.
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Shutter

This component of “Brightness” controls the amount of time which the CCD camera is
exposed to the image. The range 0.000 to 0.999 represents time through the following
equation:

t=smin + B/ Exponent x (smax-smin)
where

smin = minimum shutter time VX4000.ini
smax = maximum shutter time VX4000.ini
Exponent = 4 Transmit.Cal

B = (0.000 - 0.999)

t = microseconds

See also:
Backlight ..., 37
Brightness ..........cevvviiiinnnnn. 37
Histogram ............evvveeiinnnnnn. 56

Size in mm/inches
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Option for the Auto Calculate Dimension which will result in the “Pixels” input fields and
the “Resolution” input field being manually alterable and the “mm/inches” input fields being
automatically calculated. The most noticeable effect of this selection is that an ROl may have
its location changed on the backplane representation, but it may not be dynamically resized
using rubberbanding.

See also:
Auto Calculate Dimension ... 35
Rubberbanding .................... 82

Size in pixels

Option for the Auto Calculate Dimension which will result in the “mm/inches” input fields
and the “Resolution” input field being manually alterable, and the “Pixels” input fields being
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automatically calculated. The most noticeable effect of this selection is that you may
perform dynamic resizing using rubberbanding.

See also:
Auto Calculate Dimension ... 35
Rubberbanding ................... 82
Slope
Component of “Contrast” which determines the amount of stretch from the Pivot to be
performed.
See also:
Contrast ........ccoeeeieiiiiiiiies 46
Histogram ..........ccceeeevveneeeeen. 56
PiVOt ..o 74
o3 % Template
2 = A template is a .ph file which has been saved with a Relative ROI for use with the Frame
gz Relative ROI method.
™
g
Qp
See also:
Frame Relative ROI ............ 53
SAVe ..o, 93
Save AS i, 94
Units

The “Units:” setting determines which units of measurement will be used, either English
(size in inches, resolution in dots per inch) or metric (size in millimeters, resolution in
um/pixel). To select a type of unit, click on the toggle button next to the units you want.

See also:
English ......coooviiiiiis 50
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Vexcel Imaging

Vexcel Imaging Corporation of Boulder, Colorado, produces of the following systems:

VX3000: High resolution, high accuracy image scanner.
VX4000: High resolution, high accuracy image scanner.

AFD: Allows unattended scanning with the above systems.
IDAS: Software package performing digital aerotriangulation.

Vexcel Imaging may be reached by phone at (303)440-9790, fax (303)440-9947.

See also:
Automatic Film Drive ........... 36
IDAS ... 58
VX3000 ..o, 85
VX4000 ....ovvveiiieiieeieeen, 85
VX3000
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Original Vexcel Imaging scanning platform. Supports scanning resolutions of 8.5um/pixel to
160um/pixel, and is controlled by a SCO UNIX PC controller networked for remote storage.

VX4000

Newest Vexcel Imaging scanning platform. Supports scanning resolutions of 7.5um/pixel to
120um/pixel, and is controlled by a Windows NT PC controller operating either stand-alone
or networked.

vxformat

Software component of vxscan which formats images concurrently in the background as a
scan is being performed. May be run manually from the command line as follows:
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(Run from the destination directory, not ROI directory)
vxformat <ROI name> -fmt <format> -clean

See also:
Formats .......ccooeeviiieiiin, 51
vxscan
The actual scanning program, the execution of which will start the scanner and the Main
Window.
VXSCcanrc

This file, which is user alterable, contains the information used by vxscan to establish the
initial state of the scanner. All values within the “Current Scanner Settings” area may be
saved in a configuration which affords convenience for when the scanner is restarted.

See also:

Width

The Width parameter is located in the “Current Region of Interest Settings” area and
indicates the width of the active ROI in both mm/inches and pixels. Depending upon your
settings in the Preferences Window, at least one of the input fields will allow manual
changes to its values.
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See also:
Auto Calculate Dimension ... 35
UNIES oo 84
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CHAPTER FOUR

af ZHTE 1
Black and white imagery compliments of Aerial Services, |
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ncorporated, scanned on a VX3000Plus
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The vxscan Main Window

When you start vxscan, the vxscan Main Window (Figure 32) appears as shown below.

The vxscan window has three major areas:

Menu Bar . 1 LT | I-'-'.l RS T™T™

| e - Sl
Current Region of || e
Interest Settings ||

area | SR

; —
—
Current Scanner
Settings” area

vxscan Main Window
(Figure 32)
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Menu Bar

The menu bar (Figure 33) consists of the very top row of the Main Window. It has the
following options; File, Edit, View, Options and Help.

The menu bar

(Figure 33)
File Open, close, save and create new photo files and exit vxscan.
Edit Create and delete regions of interest (ROI's), control ROI rectangle constraints,
specify photo information, access Quick Point, and digitize points of interest.
View Display histogram and turn on the reseau light for cleaning the glass.

Options  Set preferences for units of measurement and determine which dimension will
be automatically calculated. If equipped with Automated Film Drive, open the
AFD Main Window, and open and close backplane.

File Menu

u The File Menu

(Figure 34)

The ‘File’ menu (Figure 34), located on the menu bar, contains the following options:
New
Open
Close
Save
Save As
Exit

These options allow you to create or alter .ph files, custom LUTSs, and the initialization file,
.vxscanrc. The ‘File’ menu also has the option of exiting from vxscan.
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New

Selecting this option under ‘File’ on the menu bar will result in the opening of the default
photo file with one ROI. The new photo file will be labeled “default” and will have one ROI.
This ROI will be given the name and settings of the most recently created ROI.

Open

When you select ‘Open’ you have two choices:

Photo
Custom LUT
Photo
[+ Opsa Phoio I
Selecting ‘Photo’ brings up the Open Photo Window = r.ie.
(Figure 35) from which you can open a previously saved .ph = |rrss e
file. When you select a .ph file, the scanning parameters = posis Fils

for the first ROI stored in that file appear in the “Current = frieil
Region of Interest Settings” area, and the name appears  iuesswsws
with additional ROIs from that .ph file in the regions list. '

See also
Selection Window ...................... 11 I’ - ]

Open Photo Window
(Figure 35)
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Custom LUT

Selecting ‘Custom LUT’ allows you to choose a previously
created custom look-up table (LUT) that will map the = [crsiscseriniein
scanned image values to alternate values. Berasharéa

cospramal. luk

Rt ) EER T [T A Dl [
By selecting ‘File’ > ‘Open’ - ’'Custom LUT - rarsiragy
'Monochrome/Red/Green/Blue’ from the menu bar, you ——
can load a LUT for each color channel. If a LUT has dharkard? 8, 0

derhar 7. Lt

already been loaded for a given channel, it will be closed
and replaced. ‘File’ > ‘Close’ > ‘Custom LUT’ - ‘Mono- = ===
chrome/Red/Green/Blue removes the association between
a LUT and a color channel.

[ Filies ---.-|| Helm |

See also Custom Monochrome Window

LookUp Tables ........... 64 (Figure 36)
Close

When you select ‘Close’ you have two choices:

Photo
Custom LUT

Photo

If closing a .ph file, first save any changes you may wish to keep. If the last photo file on the
interface is closed, the photo file Default.ph will automatically open.

If you choose ‘Close’ = ‘Photo’ and have made changes without saving, the following
window will pop up (Figure 37):
= ]
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vxscan Question Window
(Figure 37)
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OK Saves the file without the changes
Cancel Does not save the file and returns to the Main Window. From this point the user
can choose ‘Save’ or ‘Save As..." from ‘File’ on the Menu Bar.

Custom LUT

If closing a Custom LUT file, you will have to select which band to close. Options are
monochrome, red, green, and blue.

See also
Photo File .....ooooeeeeeeeeeeee 73
Look Up Tables .......ccccceevevueennne 66

Save

This option under ‘File’ on the menu bar presents two options:

Photo
vxscanrc.

Photo

Selecting ‘Photo’ will result in the currently open =T

and active Photo File being saved. You will be FLLi o | tvasss s et g o Lt
prompted to overwrite the existing photo file. et

(Figure 38). = e o

vxscan Question Window
(Figure 38)

.vxscanrc

Selecting ‘.vxscanrc’ will result in the scanner’s initial start-up state being saved with the
settings in the “Current Scanner Settings”. The settings will be saved in the .vxscanrc file in
your home directory and will be used as the initial setup settings next time vxscan is started.
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See also:
File MeNU ..o 90
PROLO oo 93
VXSCANIC oot 86, 93
Save As
This option under ‘File’ on the menu bar will allow a photo file

to be saved under a name you specify. A File Selection Window
(Figure 39) will appear, from which you may select an existing

e
Camaed
ammry

T E!

file to overwrite, or type in a new name. Fifepueharpie
See also:
File MeNU ......coooeeevveeeceeeceeenen, 90 [
Selection Window .............c........ 11

FLIE

Save Photo As Window
(Figure 39)

Exit

‘Exit’ exits vxscan and its associated command window. A window may appear prompting
you to save any changes you may have made to the .ph file. This option also shuts down the
scanner. It is recommended that you always exit vxscan in this way. Exiting either via the X
Window's window manager menu or other termination methods will prevent the scanner
from properly moving its Axis to a “resting” state, and may cause failures in other
applications running in the background.
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Edit Menu

- s WS T

Eiiien Fois f Edit Menu
Mis ctwcls P (Figure 40)

This selection on the menu bar is used for manipulating ROIs and digitizing points of
interest and contains the following options:

New ROI

Delete ROI

Release Point

Delete Rectangle

Quick Point

Acquire Points

Acquire Centers

New ROI

Selecting this option under ‘Edit’ on the menu bar will result in the creation of a new ROI,
which will have the same values as the most recently created ROI. The new ROl will be
represented by an inverted “L” when the mouse pointer is in the backplane representation.
To place your new ROI, move this pointer to the location where you desire the top left corner
of the ROI to be, then press the left mouse button. The ROI rectangle will then appear. You
must remember to change the name of the new ROI, even if you do not change any of its
other settings. Failure to do so will result in the new ROI over writing the previous one in
the event that both ROIs are scanned.

See also:
Region of Interest ........cccccevvveevieecevieieeene 76
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Delete ROI

‘Delete ROI’ deletes the current ROI, including the name, any parameters you have set, and
the ROI rectangle.

1  First make the ROI you wish to delete the current ROI by either highlighting the ROI
name in the List of Regions or clicking on the rectangle in the backplane
representation.

2 From the ‘Edit’ menu, select ‘Delete ROI'.

Note: You cannot delete the last ROI in a photo, as
each photo file must contain at least one ROI. If you

attempt to do so, a new ROI will be created with the
default parameter settings.

Release Point

This option releases the currently active point on the current ROI rectangle.

1  First make sure that the point you want to release is currently active. If not, click on the
point to make it active. The current point is drawn in red, others are drawn in magenta.

2 From the ‘Edit’ menu, select ‘Release Point’. The active point will then disappear, and
the ROI will be constrained by only the remaining points.
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Note: Releasing all points will result in effectively
deleting the rectangle. Similar to Delete Rectangle,
deleting the rectangle by releasing all points does not
effect the ROI. The ROI may be replaced within the
backplane representation just by placing the mouse

pointer to the location you wish to “drop” the ROI,
then clicking the left mouse button. The resulting ROI
rectangle will retain all previous settings, and will
appear with only one constraint point, on its top left
corner.

Delete Rectangle

This option under ‘Edit’ on the menu bar will result in the removal of the active ROI from
the backplane representation. The ROI's parameters, however, will remain in the “Current
Region of Interest Settings” area. The ROl may be replaced within the backplane
representation just by placing the mouse pointer to the location you wish to “drop” the ROI,
then clicking the left mouse button. The resulting ROI rectangle will retain all previous
settings, and will appear with only one constraint point, on its top left corner.

1 Make sure the rectangle you want to delete is current. The current ROI rectangle is
drawn in red, other rectangles are drawn in magenta.

2 From the ‘Edit’ menu, select ‘Delete Rectangle’. 5
3

See also: =
CoNstraint POINt .......ccocoeeueeeeeeseeeeee e 45 o

Edit MENU .ooveveeeeeeceeeeee e, 95 E
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Quick Point

‘Quick Point’ will bring up the Quick Point Pop-up Window (Figure 41) which will inform
the user that this feature has been activated. When you desire to exit Quick Point, click on
the cancel button displayed in the Pop-up Window.

X Quick Point E4

Quick Point Pop-up Window
(Figure 41)

Acquire Points

‘Acquire Points’ will bring up the Acquire Points FEETIEEIED

Window (Figure 42) which is used to digitize points of | HEN

interest (such as fiducials) on an image and save them [ ru= | |
|
|

Fid

along with the scanned image for post processing. Fig §

See also: — :
Acquire PoIntS .....cccccevcvveeveeceseece e 31 :
Frame Relative ROI .........cccccovrrvrevenene, 53 I
Acquire Point Window
(Figure 42)
Acquire Centers
2 Calculate Centers
This option is similar to Acquire Points but gives you much ; 5
greater accuracy than hand digitized points. Acquire | |center 2 -
Centers calculates the center of each point to an accuracy | |
of one-tenth of a pixel. Acquire Centers is used as part of | |==ter 2 "
the geometric accuracy test for the scanner and gives you
confirmation that the scanner is working properly. celcdlate |
Undo I Delete I
See also:
ACQUIre POINES .....cvoveeeceeeerseeee e 31 L x| [Corcet |
Edit MeNU ..o 95 Calculate Centers Window

(Figure 43)
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View Menu

[T ] View Menu
(Figure 44)

The ‘View' menu (Figure 44) contains the following options:

Histogram
Clean

Histogram

This option displays a single —
histogram for monochrome e a1 e |
iImages and three histograms "]

for color images, one each J :
for red, green,andblue.The
histogram can also be 0 | )
displayed by clicking on il o

Brightness, Contrast, or J ..
Histogram in the “Current - T
Scanning Settings” area. ! -]

|

i || | |

Color Histogram Window C

(Figure 45) (7]
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See also: s
Brightness ..o 37 =
Contrast ..o 46 2
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Clean

This function, located under the ‘View' option on the menu bar, turns off the scanner
backlight and turns on the reseau light for a fixed period of time to illuminate the glass for
ease of cleaning. A message window will appear, prompting you to click OK when cleaning
is complete.

Dirty glass, or obscured reseaus, can lead to scanning errors. The reseaus are etched into
the back side of the glass at a width of 112u and depth of 0.75u. Therefore, it is very easy
for fingerprints or other substances to prevent the reseau grid from being properly
recognized.

For best results, use 70% isopropyl alcohol (not ethyl) applied to the glass surfaces with
clean, non-abrasive and dust free wipes. clean first the reseau plane (back side of front
glass), using first horizontal then vertical strokes, end to end. Thenn clean the front glass,
and finally the backplane glass. After cleaning with the alcohol, clean with distilled water
using technique outlined above.

Options Menu

L] 5] =

] . Options Menu
Bkl By (Figure 46)

The ‘Options’ menu (Figure 46) is used for setting system preferences that affect the way
you set your scanning parameters and define your regions of interest. This menu offers
options for the Interior Orientation Transform in addition to options for the Automated Film
Drive (AFD) on VX4000 systems with AFD.
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Set Preferences
Units

This option allows the user to select the preferred —[EEEECENES
units of measurement, which are either Metric or | "=

English. e
¥ Englizh
See Units . ................ 84 fake Laleulste Disarsicn:
 Fmanlution

¥ Cizm in ew'inchax {rubbartsnding dizabled)

Auto Calculate Dimension
This option allows the user to select which

& Sizm in pixela

variables will be used to define the dimensions O liza Filn Irivs

of the ROI Enabile [nierior e vtk ion

See Auto Calculate Dimension . . 35 | | [ Carcal |
Prefergnces Window

Use Film Drive (Figure 47)

This option must be selected in order to utilize an Automated Film Drive.

Enable Interior Orientation

This option must be selected in order to enable the Interior Orientation Transform. Once
IOT has been enabled, Frame Setup will be a valid option under the “Options” menu.
Please note that both “Use Film Drive’ and ‘Enable Interior Orientation’ cannot be
selected simultaneously.

See also
Interior Orientation . ................... 61

Open Backplane/Close Backplane
This option allows the user to open/close the backlight assembly without having to do it
manually.
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Backlight on
This option allows the user to keep the backlight on during procedures which would
normally be performed with the light off.

Backlight off

This option allows the user to keep the backlight off during procedures which would
normally be performed with the light on. It is also used to turn the light off if it was turned
on using the previous option

The Frame Setup Window
Interior Orientation required the addition of the Frame Setup window.

X Frame Setup
Frame Type: If;l]eFault Frame Frame Size {mm}:
¥ ¥
o el [efault Frame
lod] [ [petete]  ore e | 230, 0000 | 2300000
) — leika_frame |

Camera Files 13.
4. _ﬂ Afiles‘wexceldbhtestroll, cam

Fiducial Finding Exposure:
3. —Fesolution I: 12,0000 Exposure Type: | MNegative =1 I| 12.
6. — Brightness: I: 2,2000 Rotation: | 180 Degrees —j 0K M{—— 11.
7 . ——Contrast: |§129.9000 Mode: | Mormal _-|

8. 9. 10.
The Frame Setup Window
(Figure 48)

1 Frame Type
The name of the frame type can be entered manually in this field or selected from the “Frame
Type” text list directly below it.
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2 Add

This button is used when creating a new frame type. A new frame type is created by typing
a name in the “Frame Type” input field and clicking on Add. This will save all the settings
in the Frame Parameters Window under that name.

3 Delete
This button deletes the frame type in the “Frame Type” input field and all of its settings.

4 Camera Database Input Field
The name of this file is entered manually by the user when fiducial accuracy is desired.

5 Resolution
Enter the resolution which the program should use when looking for fiducials

6 Brightness
Enter the brightness which the program should use when looking for fiducials

7 Contrast
Enter the contrast which the program should use when looking for fiducials

8 Mode
Enter the scanning mode - normal or mirrored

9 Rotation
Clicking on Rotation causes it to expand, giving you four choices: 0°, 90°, 180° and 270°.
These values specify how the film will be mounted relative to the Camera Database File.

10 OK Button
Clicking on OK saves all current settings.

11 Cancel Button
Clicking on Cancel closes the Frame Setup Window without saving any changes.

12 Exposure Type
Clicking on this box expands the box giving you two choices. If the undeveloped film on a
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roll is clear or light, then Negative is the appropriate setting. If the undeveloped film is
solid, or dark, Diapositive should be chosen. This setting tells vxphotolist what type of
edge to look for when scanning for edge positions in Edge of Film mode.

13 Frame Size (mm)
The X and Y measurements of the frame in millimeters.

Help

Selecting this option on the menu bar displays information regarding the vxscan release
you are using.

Current Scanner Settings

LK AL

“Current Scanner Settings” Area
(Figure 49)

This section constitutes the lower half of the Main Window and contains information
regarding how the camera “sees” an image and, therefore, how you see it on the image
monitor. The majority of this region is taken up by the backplane representation, which
displays current camera and ROI locations. To the left of the backplane representation is a
section which contains information pertaining to an image’s setup, both radiometrically and
geometrically. Any changes made here will have an immediate effect upon the displayed
image.
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It is within this region that you will make the changes necessary to bring out the best detail
possible in your imagery. Once you are satisfied with the appearance of the image, these
changes must be applied to the “Current Region of Interest Settings” area before they can
be used for performing the scan.

See also:
ApPply 10 ROI ..o 111
Current Region of Interest Settings ......... 113
Main WiNdOW ......ccooceeviieenineneeie e 89

1 Backplane Representation

Within the “Current Scanner Settings” area, a backplane representation of the 20" by 10"
backlit scanner surface is displayed in the lower right portion of the Main Window. This area
is a visual representation of the scanner backplane, containing the camera field of view and
rectangles defining ROIs. The image within the current camera field of view is visible on the
image monitor. This backplane representation is where you move the camera to roam in X
and Y, define the position of your region of interest, and digitize points of interest.

The backplane representation has three types of boxes, each with a different color:

 The camera field of view shown in dark blue
= The current Region of Interest shown in red
« All non-current ROIs shown in magenta

2 Camera Field of View

The dark blue box in the backplane representation represents the camera field of view. The
camera field of view is that portion of the backplane currently visible to the camera and
displayed on the image monitor. You may roam about the backplane by moving the cursor
into the backplane representation and pressing and holding down the right mouse button as
you move in the X and Y directions, dragging the camera field of view. Releasing the right
mouse button will cause the image to be grabbed. By adjusting the resolution (which
operates on the Z axis), you may also zoom in on a specific area. As the resolution setting
is changed, the camera field of view will become respectively larger or smaller.
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See also
Camera, Moving the camera............ccc....... 42

3 Rectangles
Rectangles represent the area of an ROI on the backplane. When red, they represent an

active ROI, when magenta, they represent an inactive ROI. Typically, one of the first steps in
defining your region of interest is to draw a rectangle around the area to be scanned.

See also:
ROI e 76
ACHIVE RO ..o 33
INACtive RO ..., 58

4 Scroll Bars

Use the scroll bars on the right and lower edges to adjust the currently visible part of the
backplane representation. To move vertically, click the up or down arrows on the right side.
To move horizontally, click the left or right arrows at the bottom. You can also click and drag
either bar.

The purpose of the scroll bars is to compensate for the difference in aspect ratios between
the backplane representation and the scanner. If the aspect ratios were the same, the scroll
bars would be full width and height and would not scroll. For ease of use, use the maximize
option of X Windows to enlarge the window as much as possible rather than using the
smaller default size.

5 Color Type (Monochrome/Color)

The Color setting specifies the type of image as either color (RGB) or monochrome. To scan
a color image in monochrome, select Monochrome instead of Color. If you select
Monochrome, one “Contrast” and one “Brightness” input field appear. If you select Color,
three “Contrast” and “Brightness” input fields appear, one for each color band (RGB).
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See also:

6 Image Type (Positive/Negative)
Positive

This setting is to be used for scanning positive imagery.

Negative

Selecting this option will allow scanning of negative imagery. The view on the image monitor
will be that of a positive, and the only discernible difference is that the histogram displayed
for a negative will have its gray levels reversed, that is instead of the x-axis on the window
representing gray levels from 0-255 left to right, they are instead represented from right to
left. This should not affect how you set the histogram.

The other option presented by the Negative button is Positive.

See also:
Brightness ......ccocoievie i 37
040 ] 1 11 =X S 46
Histogram .......ccccccevevieevie e 56
POSITIVE ..o 103

7 Intensity/Density

This button allows you to choose between scanning in Intensity or Density Mode. As a
general rule of thumb, if you have very dark or detailed imagery, or wish to bring out more
dark detail, scanning would be best performed in density mode.

See also:
DENSILY ..o 49
INEENSITY ..o 59
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8 Lookup Tables (LUTSs)

This button allows you to choose between Default LUT and Custom LUT. A Lookup Table
(LUT) is an ASCII (text) file that specifies how original or input gray values (0-255) are
mapped to output gray values (0-255).

Default LUT

This option tells the system to not use any LUTs while performing the scan. If you wish to
use LUTSs, you must select Custom LUT and specify which LUT(s) you wish to apply.

Custom LUT | e b (115 ]

If selected, Custom LUT will result in your being prompted to load

a LUT file for each color band present. For monochrome scanning, === ~
you will be prompted for one LUT, while color scanning will require e
that you open three LUTs. Vexcel Imaging provides several custom =
LUTSs for use in the directory c:\files\vexcel\lut.
See also:
Look Up Tables .................. 66 Custom Monochrome LUT
(Fig\ﬁ/rlgdsoc;gl

Tip: When using custom LUTS in color scanning, a
LUT must be open for each band (RGB). In the event
that only one band requires a LUT, the one2one.lut file

performs no mapping, and must be applied to the
other bands. This and all other Vexcel provided LUTs
are located in the directory c:\files\vexcel\lut.
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Tip: Also in the c:\files\vexcel\lut directory is an Excel
spreadsheet file which contains values which allow you

to create your own custom LUTs. This tool is simple
to use, and will allow you to create LUTs for your
specific film type.

9 Resolution - nccisizn B

There are three ways to change the resolution:

e Click Resolution in the “Current Scanner Setting” area to display the
Resolution Window (Figure 51). Drag the slider to adjust the resolution.

e Type the resolution value into the input field below the Resolution
button in the “Current Scanner Settings” area. i

e Type the resolution value into the input field below “Resolution” in the
“Current Region of Interest Settings” area. If you wish this change to
affect the Current Scanner Settings, then you must click Apply to
Scanner. Li=] |

Resolution Window
(Figure 51)

10 Filters

The VX4000 comes with 4 filter options, No Filter, Low, Medium, and High. These filters
are 3x3 high pass convolution filters of varying strength. If you select a filter in the “Current
Region of Interest Settings” area, you must click Apply to Scanner for the change to have an
effect on the Current Scanner Settings.

c
[}
m
A
z
-
m
2
B
3]
m

109



User Interface
I

Tip: When using a filter, select the filter before

adjusting the brightness and contrast, as filters will
affect the radiometry of your scan.

11 Brightness

Clicking Brightness will bring up the Histogram Window (Figure 52) in which brightness and
contrast for the ROI can be adjusted. The brightness adjustment effectively shifts the entire
histogram either to the right (brighter) or to the left (dimmer), without having much effect
on the range of the gray levels used. To adjust brightness, move the camera field of view to
the brightest parts of the image and look at the histogram. Using the slide bars on the right
side of the Histogram Window, adjust the histogram until there are just a few pixels at 255.

The value for brightness can also S — |
be entered manually in the input N

field just below the Brightness

button. As the number in this _
input field is increased, the
intensity of the light from the

scanner increases.

When setting Brightness for an ————== —— L B

w

g image, be sure to use the Hist@?;:ﬂe\ggdow
& resolution you will use at

= scanning time.

ﬁ See also:

=) Brightness ... 37
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12 Contrast

Clicking Contrast will bring up the Histogram Window (Figure 53). The “Contrast” control
can be thought of as the "stretch” factor. Contrast is always set after the brightness has been
properly adjusted. To adjust contrast, move the camera field of view to the darkest parts of
the image and look at the histogram. Using the slide bars on the left side of the Histogram
Window, adjust the histogram until there are just a few pixels at 0.

The value for contrast can
also be entered manually in
the input field just below the
Contrast button. The numbers
to the right of the decimal
determine the amount of
stretch (.999 for the most,
501 for the least) or
contraction (.001 for the
most, .499 for the least) that —— =

will be applied to the H'St(‘;?gif;‘;g“mw

histogram. The numbers to

the left of the decimal determine where on the histogram the pivot point will be located. It
is from the pivot point that the histogram will be stretched or contracted.

When setting Contrast for an image, be sure to use the resolution you will use at scanning time.

See also:
LO00] ] (= 1) A 46
PiIVOL e 74

13 Apply to ROI

Selecting this function will result in the settings within the “Current Scanner Settings” area
being applied to the “Current Region of Interest Settings” area. Once you have set up an
image in the “Current Scanner Settings” area, you would need to apply these settings to the
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“Current Region of Interest Settings” area if you wish your scan to be performed with those
settings.

See also:
Apply to Scanner ........ccccvveeveevee e, 114
Current Scanner Settings .......cccceceevieeinens 104

14 Accurate/Approximate

vxscan operates in two modes, Accurate and Approximate. Accurate Mode uses the reseau
grid to determine the camera position, while Approximate Mode does not. For this reason,
use Approximate Mode while roaming and zooming for faster movement as you preview an
image, and use Accurate Mode to precisely position your ROI rectangles relative to the film.

See also:
ACCUIALE ..o 29
APProXimate .......ccoeeererererese e 34

15 Histogram

Clicking on the Histogram button opens the Histogram Window. This window may also be
opened from the Contrast and Brightness buttons or by selecting ‘View' - ‘Histogram’ on
the menu bar.

See also:
Brightness ..o 37
LO70] 011 ¢= 1] SRR 46
HIStOgram ........ccceoeieienenenenese e 56
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Current Region of Interest Settings

“Current Region of Interest Settings” Area
(Figure 54)

This section constitutes basically the top half of the Main Window and contains
information pertaining to the ROIs which you intend to scan. On the far right of the
screen is the List of Regions with the names of all ROIs present, and the active ROI
highlighted. In the center of the screen are text fields indicating the current Photo File
and the ROI path and name. ROI specific settings are present under these two fields as
well as to their left. The far left of the screen contains the same settings fields as found
within the “Current Scanner Settings” area, which constitutes the lower half of the main
window. Since the settings in the “Current Region of Interest Settings” area are the ones
which will be used when a scan is performed, it is important that any settings made within
the “Current Scanner Settings” area be applied to the ROI by clicking Apply to ROI before

starting your scan. Likewise, if you wish to see how the values within the “Current Region 5
of Interest Settings” area will affect your imagery, you may make these settings current for 2
viewing by selecting Apply to Scanner. z
m
See also: E
Apply to Scanner .........cccccevveveveesee e 114 o

Current Scanner Settings ........ccccceeeeveenen. 104

Main WiNdOW .......cooceeveieenineneeie e 69
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1 Apply to Scanner

This button applies all of the settings in functions numbers 9 & 12 within the “Current
Region of Interest Settings” area to the corresponding Current Scanner Settings areas.
Changes you make to the Current Region of Interest Settings are not automatically used by
the Current Scanner Settings when you preview the image. You must click Apply to Scanner
to apply those settings to the Current Scanner Settings in order to preview the changes on
the image monitor.

See also:
APPIY t0 ROI .. 111
Current Region of Interest Settings ......... 113
2 Photo

A photo file name may be assigned to each photo that is mounted for scanning. Within each
Photo file, one or many regions of interest (ROIs) may be defined, each with a specific ROI
file name. In addition, multiple photo files may be viewed and used at one time. Each photo
file has a name with a .ph extension. New .ph files may be named anything you want, as long
as they follow NT naming conventions and have a .ph extension. Photo files do not need to
be saved in order to scan an image, but you must save photo files if you wish to preserve
the scanning parameters and any digitized points.

When you open an existing photo file, all of the regions of interest for that photo file are
displayed in the list of regions on the right-hand side of the Current Region of Interest
area. The name of the current photo file is displayed in the photo description field and
the name of the currently selected region of interest is displayed in the ROI field. You may
open as many photo files as you want, each with varying numbers of ROIs.

See also:
PROtO Fl@ oo, 73
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Tip: When naming photo files, it is often convenient
to assign a name which pertains to the job you are
performing. This would include, for example,
customer names, location names, or if you wish to be
more specific, flight line or frame numbers (if
applicable). Remember to always designate your photo
file with a .ph extension.

Note: Images can become very large, and scanning in
color requires three times the amount of disk space as
a monochrome image, so select directories
accordingly.
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3 ROI:

Scanned regions are stored in sub-directories that are created using the file name specified

in the ROI text field. This sub-directory is where tiles, information files, and formatted

images are stored. For example, if you specify c:\\images\atlantan the ROI text field, an

image sub-directory called atlantais created under the directory c:\images c:\images
must already exist and have write permissions. The scanned regions are given file extensions

to specify the type of image file. In the above example, if Tiff was selected as the format

type, the final image file atlanta.tifwill be present in the sub-directory c:\images\atlanta
See File Naming Conventions for the extensions that vxscan assigns. vxscan uses the default

ROI directory name, Untitled, until you supply one. If you decide not to supply an ROI file

name and use the default name of Untitled, a directory called Untitled is created in your

current working directory when you scan.

To name the current Region of Interest:

1. Click on the ROI input field to open the Prompt_pop-up Window (Figure 55) where you
will change the ROI name. Use the <Backspace> or <Delete> keys to delete any
existing name such as "Untitled” that may already be in the window.

2. Type an absolute path name (if different than the directory in  ErrT=—T"
which you are working) followed by the new directory Nname e s simcore s
for the region of interest. The name appears in the list of = [ieicies |
regions on the right when you click outside the text field or
press <Enter>. vxscan checks to see if you have write % | [cwcea] [ et |
permission for the given directory.

Prompt_popup Window

w (Figure 55)
0

g See also:

& Region of INtErest.......cccvvevveerererrieeene, 76

5 Region of Interest,

= File Naming Conventions.................c......... 78

%

=
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4 List of Regions

Located in the upper right side of the “Current Region of Interest Settings” area, this text
field lists the names of all ROIs which are currently accessible. The active ROI will be
highlighted.

S5 Format
vxscan uses several settings in the “Current ry—
Region of Interest Settings” area to determine i | [weel o] [l o
how the image will be processed and stored. s N e
Options are given for format type, whether the :i '
image is Mirrored or Normal, and whether the I rih: | o
ROl is Relative or Absolute. :;:' s | . 104

0T Ao S
vxscan supports the following image formats: #
Native, BSF, BIP, BIF, TIFF, SunRaster, IS, Format Options Button

(Figure 56)

COT, tiled TIFF, and IMG. Here are brief
explanations of each of the image formats.

No Format

Option to keep the raw data tiles of a scan without formatting them together.

See also:

Formats, No Format...........cceeeeeeeeeeeeeeeen, 51
BIF c
m
Binary Information File format. :
2
See also: ::l':
Formats, BIF ..., 51 g
m
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BIP

Band Interleaved by Pixel format.

See also:
Formats, BIP ... 51

BSF

Band Sequential File format.

See also:
Formats, BSF ..., 51

COT Row

Intergraph proprietary format.

See also:
Formats, COT ROW ....oooveveeeeeeeeeeeeeeeeen, 52

Imagine

Erdas Imagine proprietary format (.img).

See also:
Formats, Imagine ........cccccevveeveecceeieecnenn, 53

SunRaster
Format files used primarily on Sun workstations.

See also:
Formats, SunRaster ......ccccccveeeeeiiiieieeeeinn, 52

118



User Interface

TIFF

Tagged Interchange File Format.

See also:
Formats, TIFF .....ooeeeeieiieiieeeeveveeeeeveeeveeeeees 52

Tiled TIFF

Tiff files which are formatted in tiles of a size which may be user specified.

See also:
Formats, Tiled TIFF ..o 52
6 Host

The host is the location on the network where the scanned image will be stored. The host
can be on Unix, Windows95, or WindowsNT.

This button will give you a choice of Unix machines that have been mounted on the
controller or Local. Local is chosen if you want the host to be a directory on a Windows95
or WindowsNT machine. To use local, the directory must first be mounted in the Control
Panel on the controller.

See also:
System Configuration ............ccoceveerenenene 8

7 Normal/Mirrored

Normal

This option will result in the final scan having the same orientation as the source image.
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Mirrored

This option, which appears in the “Current Region of Interest Settings” area, will result in
the final scan being a mirror image of the source photograph, as opposed to Normal, which
will scan the image just as it appears in the backplane. You would select Mirrored if you had
to mount an image backwards in order that the emulsion faces the reseau. If the writing on
the image in the backplane is backwards, then chances are you should choose mirrored. This
is often the case when scanning negative imagery.

8 Absolute/Relative

This feature has the effect of specifying the ROI which you have active as an absolute ROI.
This means that the location of the region of interest is fixed and will not shift through
automatic means by the use of Frame Relative ROI. The dimensions and location of the ROI
may still be altered manually.

See also:
Frame Relative ROI ... 53
REIALIVE . eeeeeeeeeenenes 79

9 - 10 Region of Interest Size

The current region of interest's size is determined by three variables:

« Resolution (in micrometers per pixel or dots per inch)
= Physical size (height and width)
* Pixels

Changing any of these variables will affect the others. For example, if you change any one
of the variables either by typing in values or by rubberbanding the ROI rectangle, the other
values will change accordingly.

One of these three variables is calculated from the other two, and may not be specified

dynamically. You can select which one of these variables vxscan will automatically calculate
for you by setting the Auto Calculate Dimension in the vxscan Preferences Window. For
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example, if you select “Resolution” for automatic calculation, you can alter the size of the
region of interest in inches, millimeters or pixels. vxscan will then automatically calculate
the resolution.

Resolution

In its standard configuration, the VX4000 supports resolutions from 7.5um/pixel to
120um/pixel. The desired resolution may be specified manually by typing it in the input field
labeled “Resolution” (unless resolution is specified as your Auto Calculate Dimension), or
a resolution slider bar may be opened by clicking Resolution in the “Current Scanning
Settings” area.

Physical Size

The width and height of the scanned area are measured either in metric with millimeters or
in English with inches, according to the units you select in the vxscan Preferences Window.

Pixels:

Pixels specifies the dimensions of the scan area in pixels.

See also:
Set Preferences ... 101

11 Image Size

After all settings have been made, vxscan shows the user the estimated size of the file
from the resulting scan.

12 Resolution and Radiometric Controls
The resolution and radiometric controls are the same in the “Current Region of Interest

Settings” area as they are in the “Current Scanner Settings” area with the following
exceptions:
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e There is no slider control window for adjusting resolution. Instead, you have
only the option of entering a specific resolution value in the input field.

= Similarly, the Contrast and Brightness can only be adjusted by entering
specific values in the input fields.

13 Scan

Once the radiometry, position, and other values of an ROI have been established, the actual
scan may be performed by clicking Scan. Only the active ROI will be scanned, any other
ROIs in the List of Regions will not be scanned. To scan every ROI, you must click Scan All.

14 Scan All

Clicking Scan All will result in all of the ROIs in the List of Regions being scanned. If you
wished to scan one individual ROI, make that ROI active (by selecting it in the List of
Regions) then click Scan as opposed to Scan All.
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Appendix |
|

Summary of Default Settings for rtinfo.ini Flags

Flag:

ReseauProcessing
LongReseauDisplay:
ReportReseauBrightness:

ViewReseauAccums:
ViewReseauGrabs:
ViewReseauPoints:
ViewEnhancedReseaus:

ViewReseauEnhanceKernels:

SaveReseauGrabs:
SaveReseauPoints:
SaveEnhancedReseaus:

ApplySubPixelinterp:
ApplyWeighting:
ApplySubPixelCulling:
ApplyPointCulling:
ApplyGammalut:

LogReseauFailures:
CalcPixRMS:

LoadReseauCal:
CreateReseauCal:
UseReseauCal:
ReportReseauCal:

CreateDistField:
ReportDistField:
PerformSecondPass:
TileReseaus:

DontApplyResLut:
ViewResLut:

Default Setting:

M T T T T mal

mal

i B e i R B | mal

m T

m T T m M T T m

mal

123

Effect of Non-Default Setting:

All reseau grabs displayed on image monitor
Reseau point information reported to console

Enables viewing of reseau grab process
Enables viewing of reseau grab process
Points collected by reseau finder are viewed
Enables viewing of enhancement process
Reseau kernels printed to console window

Reseau grab images saved to disk as .tif file
Reseau point images saved to disk as .raw file
Two enhanced reseaus saved to disk as .raw files

No reason to change from default setting

No reason to change from default setting
Collected points are culled

Collected points culled if far from reseau

Reseau image is mapped through an additional lut

All reseau points printed to a log file if RMS >1.0
Brute-force calculation of the RMS is performed

Reseau plate calibration file is loaded

A statistical summary of the RMS is created
Reseau errors are calibrated with aide of statistics
No reason to change from default setting

A distortion field is created for the camera

An image will be written out of the distortion field
All reseau points culled based on found transform
Currently for use by Vexcel Imaging only

Reseau grabs are not run through reseau lut
Reseau LUT is printed to console window
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Appendix

LoadResLutEveryGrab:

DoOverwriteRad:
UseOldReseauFinder:
LogReseauShutterVal:
"ResRezShutter.log"

RadiometryProcessing

DisplayRadGrab:
DontApplyBackModel:

LeaveBacklightOn
LeaveCameraTriggering
DontApplyFalloff:
DontApplyFlatField:
SaveBackModel:
SaveFalloff:

SaveGrabbed:
SaveCorrected:

SaveBlurred:
SaveResampled:
SaveSharpened:
SaveFlatFieldDebug:
LogSingleFlatFieldLut:
LogMultiFlatFieldLut:
DontProcess:

BruteForceResample:
SingleSnapRawHisto:
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Reseau LUT is loaded to software during scanning

Currently for use by Vexcel Imaging only
The "old" reseau finder is utilized
resolution and reseau shutter to

Radiometry grab is displayed during scanning
Backmodel corrections not applied during
scanning

Leaves backlight on between photolist scans
Allows camera warm up by continuously triggering
Falloff corrections not applied during scanning
This flag is currently obsolete - always set to T
Backmodel correction saved to disk as .raw file
Falloff correction saved to disk as .raw file

Radiometry grab is saved to disk as 16 bit .raw file
Radiometry grab is saved to disk as 8 bit .raw
image

Radiometry grab is saved to disk as 8 bit .raw
image

Radiometry grab is saved to disk as 8 bit .raw
image

Radiometry grab is saved to disk as 8 bit .raw
image

This flag is currently obsolete - always set to F
This flag is currently obsolete - always set to F

This flag is currently obsolete - always set to F
Files are not radiometrically processed

An exact resampling of the tile is performed
A raw radiometric grab is displayed on the monitor



Appendix |
|

DCXinfo
ViewWrite:
ViewRead:
Formatterinfo
Tilting:
Blending:
Cleaning:
Output:
Borders:
RadStats:
GeoStats:
RemotelODebugging:
AFDInfo
ViewWrite:
ViewRead:

LogEdgeFindingFailures:
UseSimpleWideFind

HardwareChecks

QuickHardwareChecks:

CompleteHardwareChecks:

M T T A A~
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Commands sent to DCX board are printed to
console
Responses from DCX board are printed to console

Tilting will not occur during formatting

Blending will not occur during formatting

Tile files and .rh file are not deleted

This flag is currently not in use - always setto T
This flag is currently not in use - always set to F
Radiometric statistics are printed during formatting
Projection error at each tile border is calculated
Remote file I/O server prints debug info to console

Commands sent to AFD controller printed to
console
Responses from AFD controller printed to console

Tile is saved and edge image is written to disk
Takes a single grab during widefind

Quick hardware checks performed while scanning
Complete hardware checks performed while
scanning
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VX4000.ini File

* VX4000 Initialization File *

Insert comments wherever you like...

; A leading semicolon ensures that nothing on the line gets processed,

but as long as your comments do not include a valid parameter name followed
directly by an equals sign, i.e.

ValidParameterName= random commentary text

they will not affect the interpretation of this file.

Extra lines are ok too...

Note, however, that valid parameter names must be followed directly by an
equals sign. Both of the following are valid:

ValidParameterName=parameter string
ValidParameterName= parameter string

;- Begin initialization data

[Common]

ScannerName= VICXX_VXtyy
Scanner|D= 0
ScannerType= thor
AspectRatio= 1.000
FrameDepth= 8
CameraType= PulnixTM1001
BoardType= KCS

FrameGrabberType= ITI_CLU

[FrameDefinition]

; overlap for both x and y, acquisition and formatting

TileOverlap= 8

; minimum frame border around tile
SlopInMicrons= 200
SloplInPixels= 20
PositioningTolerance= 500
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[ReseauManager]

1

TakesLutFile=\files\vexcel\cal\restake.lut
PointsLutFile=\files\vexcel\cal\respoint.lut
BadReseauLimit= 1

[ReseauKernel]

1

; maximum reseau kernel length is 128
LoPassLength= 16 16

LoPass¥lue= 11
LoPassDivisor= 44
HiPassDivisor= 55

KernLengthOfset= 6 6

; The double-line separation depends upon the master backplate.
; For 1701.80, use 109.6
; for 3505.20, use 92

; Double line sep for T1 plate
; DoubleLineSep= 94.4
DoubleLineSep=  109.6

Exponent= 66

Multiplier= 22

Scalar= 4000 4000

FullLength= 508000 254000
HalfLength= 221000 221000 221000 221000
lo= 100 100 100 100

Bias= 00
GammalLutFile=\files\vexcel\cal\resgamma.lut
PosSpaceScalar_White= 1.0 1.0
PosSpaceScalar_Red= 1.0 1.0
PosSpaceScalar_Green= 1.0 1.0
PosSpaceScalar_Blue= 1.0 1.0

[ReseauFinder]

1

ResOfset= 0.00 0.00
ResCellSize= 1701.8
Res2HorizonDeg= -2.5
Res2FramednHorz=0.027
Res2Framedn\ert= 0.027
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VR_MotorSpacedReseau_Ang= -2.5
RejectThreshold= 10
R2ICoefs= 1001

; 1 means do shift and add, 0 means do shift and multiply
DoshiftAndAdd= 0

; If "ResLutSource= formula”, then the res lut formula paramaters below

; will be applied, otherwise, we assume that ResLutSource points to a text
; file which containts sequential entires for an 8 bit lut which will be

; applied to the non-clipped region (0-255) of the reseau grabs

;ResLutSource= \files\vexcellut\8-bit-lin.txt
ResLutSource= formula

; Settings for try 4
ResLutLinearStartX= 0
ResLutLinearEndXY= 55
ResLutExponent= .25

; Settings with best results
;ResLutLinearStartX= 0
;ResLutLinearEndXY= 108
;ResLutExponent= .20
[Radiometry]

BacklightCalFile= \files\vexcel\cal\backlight
FalloffCalFile= \files\vexcel\cal\fallof.cal
FlatfieldCalFile= \files\vexcel\cal\flatfield.raw
DenseMapCalFile= \files\vexcel\cal\densemap.cal

BacklightimageSizeX= 608
BacklightimageSizeY= 354
BacklightPositionOfsetX= 51250
BacklightPositionOfetY= 51250
BacklightimagePixelSize= 1000.0
BacklightimagePixelAspectRatio= 1.00

MaxFlatField\alue= 85
CameraGamma= 0.45

FalloffClippingFraction=.0001

[DeviceParams]

XYSettleTime= 50

;It only takes 9H = 575 us to set the shutter
ShutterSetSettléme= 1
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; The length of time to settle the trigger is determined by the length of the
; shutter If the shutter isn't done, when the ITI card snaps, then the ITI card
; will go ahead and wait the correct amount of time....

ShutterTiggerSettleTme= 10
ResLiteOnSettleime= 10
ResLiteOfSettleTime= 10
BackLiteOnSettleime= 50
BackLiteOfSettleTime= 50
BackLitelntensitySettleime= 10
FilterMoveSettleTme= 300

;The minimum shutter in 2H = 65*2 us. The smallest practical shutter is probably 500us

CamsShutterLimits= 500 300000
BackLiteLimits= 0.5 1.0
WheelLimits= 0 5000
ReseauShutter= 105000
DefaultLiveMewShutter= 50000

[CalibrationFiles]

1

FilterWheel= \files\vexcel\cal\wheel.cal
Transmittance= \files\vexcel\cal\transmit.cal
VxAfdCal= \files\vexcel\cal\vx_afd.cal
ResRezName= \files\vexcel\cal\ResRez.ini

[LightBoardInitStrings]

1

NumEntries= 16

r0= chl,ch2,ch3,ch4,ch5,ch6,ch7,ch8,cl9,clA,clB,clEctlio
rl= ctl,ct2,ct3,ct4,ct5,ct6,ct7,ct8,ctB,ctE,ctE0
r2= ¢nl10,cf10

r3= cnE,cfE

r4= cn5

r5= ctA

ré= cnA,cfA

r7= ct9

r8= cfl,cn2,cn3,cf4,cn5,cf6,cf7,cn8

r9= cnkcfF

r10= cn9,cf9

rl1= cn9,cf9

rl2=cn9,cf9

r13=cn9,cf9
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rl4=cn9,cf9
r15=cn9,cf9
;rl6= cfl
;rl7= cnB,cfB

[FilterWheel]

MotorParams= wa200,5si28,5svFD,5saFE,wa200
HomingString= wa200,5siD0,5mn,5fe,5si28,5fe,5dh0,wa200
[DcxBoard]

InitString= hm

CheckSum= E121

ComPort= COoM2

[Formatting]

ImagineAuxDir= \files\vexcelauxiliary\imagine
TempCacheDir=  \temp

RamCacheMemory= 0

TileGroupMemory= 16

OutputTileSize= 512

TargetHosts= kali priapus idas veximgixuoZo
LastUsedPort= 6187

FormatterName=  /usr/bin/rio_server

PortRange= 6000 6500

; number of diferent ports each rio server request should try
SocketSpawnAttempts= 3

; Number of times each client should request a connection
; with the server before failing
SocketConnectAttempts= 15

; Number of milliseconds the client should wait between connection attempts.

SocketSleepLength=10

[AFD]

Enabled=F
ComPort= COM1
TempPhotoDir= \temp
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num_tags int
roi_path str

roi_base str

format int
device int
offul_x int
offul_y int
ul_x dbl
ul_y dbl
ur_x dbl
ur_y dbl
I_x dbl
Iy dbl
Ir_x dbl
Ir_y dbl
sizpix_x int
sizpix_y int
resmp dbl 1
depth_w bool 1
depth_r bool 1
sat_r dbl 1
contrast_r  dbl
depth_g bool 1
sat g dbl 1
contrast_g  dbl
depth_b bool 1

e s s e

—

sat b dbl 1
contrast_ b dbl
overlap int 1
filter int 1
point_num int
ps_point_x  dbl
233752.968419
ps_point_y  dbl
241167.206059
cal_point_x  dbl
10.000000
cal_point_y  dbl
112002.000000
pix_point_x  dbl
4719.921237
pix_point_y  dbl
9026.930796

point_coef  dbl
point_name  str

fiducial2
fiducial3
fiducial4
fiducial5
fiducial6
fiducial7
fiducial8

ah File

1 52
1 wulO3L

1 wulO3L

O oo o

115754.937487
15493.936169
348579.937487
15493.936169
115754.937487
243868.936169
348579.937487
243868.936169
1 9313
1 9135
25.000000
0
1
2.451000
1 255.558000
1
2.421000
1 255.558000
1
2.519000
1 255.567000
20

0

1 8

8 127839.231700 337554.771458 125831.878992 339557.418700 120850.210286 344533.073101 231644.493178

8 236174.304348 22435.862695 24405.318663 234187.78708!

0 130348.975518 128255.521074 17441.012504

8 -105987.000000 106003.000000 -105994.000000 106012.000000 -111981.000000 111999.000000 4.000000

fid_point_num int 1 8

8 -106007.000000 105987.000000 105988.000000 -106007.000000 -10.000000 -10.000000 111980.000000
8 483.371769 8871993359  403.077660 8952.099249  203.810912 9151.125425  4635.582228
8 8827.214727  277.677061 356.455300 8747.754036  4594.201574  4510.463396  77.883053
8 0.873090 0.913180 0.923814 0.928650 0.834419 0.918450 0.828816 0.918471
8 fiduciall
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fid_point_list int 8
dig_point_num int
acg_point_num int
edge_point_num int
ref_point_num int
cam_img_iot  dbl
img_cam_iot  dbl
img_cam_iot_res_x
0.002091
img_cam_iot_res_y
0.001501
img_cam_iot_res_xy
0.002574
img_cam_iot_rms_x
img_cam_iot_rms_y
img_cam_iot_rms_xy

6
dbl

dbl
dbl
dbl

dbl
dbl

3 4 5 6 8
0
0
0
4677.289353  39.947392 -0.376328 4551.921027  -0.373504 -39.955307
-116.002766  0.025031 -0.000236 115.009717  -0.000234 -0.025026
8 -0.002297 -0.001140 0.003479 -0.000366 0.003349 0.005894
8 0.004150 0.002305 -0.006837 -0.002832 0.001361 -0.000684
8 0.004743 0.002571 0.007671 0.002855 0.003615 0.005933
1 0.003804
1 0.003503
1 0.005171
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